
Quantifiler® Duo DNA 
Quantification Kit

User’s Manual



DRAFT
April 11, 2008 1:14 pm, 7x9_Title.fm

© Copyright 2008, Applied Biosystems. All rights reserved.

For Research, Forensic, or Paternity Use Only. Not for use in diagnostic procedures.

Information in this document is subject to change without notice. Applied Biosystems assumes no responsibility for any errors that 
may appear in this document.

APPLIED BIOSYSTEMS DISCLAIMS ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THOSE OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. IN NO EVENT SHALL APPLIED BIOSYSTEMS BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, 
OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, 
MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, 
INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

NOTICE TO PURCHASER: LIMITED LICENSE

Use of this product is covered by one or more of the following US patents and corresponding patent claims outside the US: 
5,079,352, 6,127,155, 5,677,152 (claims 1–23), 5,773,258 (claims 1–10), 5,210,015, 5,487,972, 5,804,375, 5,538,848, 5,723,591, 
5,876,930, 6,030,787, and 6,258,569. U.S. Patent Appl. No. 60/890,817 is filed for the Quantifiler Duo DNA Quantification Kit. 
The purchase of this product includes a limited, non-transferable immunity from suit under the foregoing patent claims for using 
only this amount of product solely in forensic and paternity testing, including reporting results of purchaser’s activities for a fee or 
other commercial consideration, and also for the purchaser's own internal research. No right under any other patent claims (such as 
apparatus or system claims in U.S. Patent No. 6,814,934) is conveyed expressly, by implication, or by estoppel. Further information 
on purchasing licenses may be obtained from the Director of Licensing, Applied Biosystems, 850 Lincoln Centre Drive, Foster 
City, California 94404, USA.

TRADEMARKS:

Applera, Applied Biosystems, AB (Design), ABI PRISM, AmpFLSTR, Blood Prep, GeneMapper, Identifiler, MicroAmp, 
Quantifiler, VIC, and Yfiler are registered trademarks and FAM, JOE, MiniFiler, NED, ROX, and TAMRA are trademarks of 
Applera Corporation or its subsidiaries in the U.S. and/or certain other countries.

AmpliTaq Gold and TaqMan are registered trademarks of Roche Molecular Systems, Inc.

All other trademarks are the sole property of their respective owners.

Part Number 4391294 Rev. B
04/2008



Contents
Preface
How to Use This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  v

Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  vii

How to Obtain More Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xi

How to Obtain Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xi

Chapter 1 Overview
Product Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-2

Chemistry Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-3

Instrument Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-7

SDS Software Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-8

Real-Time Data Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-9

Quantifiler® Duo Kit Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-15

Materials and Equipment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1-16

Chapter 2 Software Setup
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-2

Starting the 7500 Real-Time PCR System  . . . . . . . . . . . . . . . . . . . . . .  2-3

About Plate Documents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-6

Setting Up a Plate Document   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2-8

Setting Up a Plate Document Template  . . . . . . . . . . . . . . . . . . . . . . .  2-26

Chapter 3 PCR Amplification
Preparing the DNA Quantification Standards . . . . . . . . . . . . . . . . . . . .  3-2

Preparing the Reactions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-5

Running the Reactions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3-7
Quantifiler® Duo DNA Quantification Kit User’s Manual iii



Chapter 4 Data Analysis and Results
Analyzing the Plate Document   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-2

Viewing Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4-4

Chapter 5 Interpretation of Results
Checking Analysis Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-2

Examining the Standard Curve  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-3

Troubleshooting the Standard Curve . . . . . . . . . . . . . . . . . . . . . . . . . .  5-5

Using the Internal PCR Control System . . . . . . . . . . . . . . . . . . . . . . .  5-13

Troubleshooting Amplification Plots   . . . . . . . . . . . . . . . . . . . . . . . . .  5-15

Assessing Quantity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-19

Calculating Male : Female DNA Ratio  . . . . . . . . . . . . . . . . . . . . . . . .  5-20

Improving Assay Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5-20
Assessing Sensitivity and Results . . . . . . . . . . . . . . . . . . . . . . . .  5-20
Assessing and Troubleshooting False Positive Results  . . . . . . .  5-22
Preventing PCR Contamination . . . . . . . . . . . . . . . . . . . . . . . . . .  5-23

Chapter 6 Experiments and Results
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-2

Developmental Validation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6-3

Bibliography

Index
iv Quantifiler® Duo DNA Quantification Kit User’s Manual



Preface
This preface contains:

How to Use This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  v
Safety. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
How to Obtain More Information . . . . . . . . . . . . . . . . . . . . . . . . . .  xi
How to Obtain Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  xi

How to Use This Guide

Purpose of This
Guide

The Quantifiler® Duo DNA Quantification Kit User’s Manual 
provides information about and instructions for using the 
Quantifiler® Duo DNA Quantification Kit.

Audience This manual is intended for scientists who use the Quantifiler® Duo 
DNA Quantification Kit for the quantification of human DNA 
extracted from a variety of sample types. It requires familiarity with 
the 7500 Real-Time PCR System and 7500 SDS software.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for 
emphasis. For example:
Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you 
select from a drop-down or shortcut menu. For example:
Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All 
Runs.
Quantifiler® Duo DNA Quantification Kit User’s Manual v
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User Attention
Words

Two user attention words appear in Applied Biosystems user 
documentation. Each word implies a particular level of observation 
or action as described below:

Note: Provides information that may be of interest or help but is not 
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you 
need a valid Oracle user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet 
for each 96-well plate.

Safety Alert
Words

Safety alert words also appear in user documentation. For more 
information, see “Safety Alert Words” on page vii. 

Pull-out Chapters This User Manual contains individually bound chapters (Chapter 2 
through Chapter 6) that the user can pull out of the binder to use in 
the lab. 
vi Quantifiler® Duo DNA Quantification Kit User’s Manual



Safety
Safety

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user 
documentation at points in the document where you need to be aware 
of relevant hazards. Each alert word–IMPORTANT, CAUTION, 
WARNING, DANGER–implies a particular level of observation or 
action, as defined below:

IMPORTANT! – Indicatesinformation that is necessary for proper 
instrument operation, accurate chemistry kit use, or safe use of a 
chemical. 

 – Indicates a potentially hazardous situation that, 
if not avoided, may result in minor or moderate injury. It may also be 
used to alert against unsafe practices. 

 – Indicates a potentially hazardous situation that, 
if not avoided, could result in death or serious injury. 

 – Indicates an imminently hazardous situation 
that, if not avoided, will result in death or serious injury. This signal 
word is to be limited to the most extreme situations.

Chemical Hazard
Warning

CHEMICAL HAZARD. Some of the chemicals 
used with Applied Biosystems instruments and protocols are 
potentially hazardous and can cause injury, illness, or death.
Quantifiler® Duo DNA Quantification Kit User’s Manual vii
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Chemical Safety
Guidelines

To minimize the hazards of chemicals:

• Read and understand the Material Safety Data Sheets (MSDS) 
provided by the chemical manufacturer before you store, handle, 
or work with any chemicals or hazardous materials. (See “About 
MSDSs.”)

• Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (for example, 
safety glasses, gloves, or protective clothing). For additional 
safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (for 
example, fume hood). For additional safety guidelines, consult 
the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill 
occurs, follow the manufacturer’s cleanup procedures as 
recommended on the MSDS.

• Comply with all local, state/provincial, or national laws and 
regulations related to chemical storage, handling, and disposal.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets 
(MSDSs) with shipments of hazardous chemicals to new customers. 
They also provide MSDSs with the first shipment of a hazardous 
chemical to a customer after an MSDS has been updated. MSDSs 
provide the safety information you need to store, handle, transport, 
and dispose of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous 
chemical, be sure to replace the appropriate MSDS in your files.

Obtaining MSDSs The MSDS for any chemical supplied by Applied Biosystems is 
available to you free 24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click 
MSDS Search. 

2. In the Keyword Search field, enter the chemical name, product 
name, MSDS part number, or other information that appears in 
the MSDS of interest. Select the language of your choice, then 
click Search.
viii Quantifiler® Duo DNA Quantification Kit User’s Manual
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Safety
3. Find the document of interest, right-click the document title, 
then select any of the following:
• Open – To view the document
• Print Target – To print the document
• Save Target As – To download a PDF version of the 

document to a destination that you choose

Note: For the MSDSs of chemicals not distributed by Applied 
Biosystems, contact the chemical manufacturer.

Chemical Waste
Hazard  CHEMICAL WASTE HAZARD. Some wastes 

produced by the operation of the instrument or system are potentially 
hazardous and can cause injury, illness, or death.

Chemical Waste
Safety Guidelines

To minimize the hazards of chemical waste:

• Read and understand the Material Safety Data Sheets (MSDSs) 
provided by the manufacturers of the chemicals in the waste 
container before you store, handle, or dispose of chemical waste.

• Provide primary and secondary waste containers. (A primary 
waste container holds the immediate waste. A secondary 
container contains spills or leaks from the primary container. 
Both containers must be compatible with the waste material and 
meet federal, state, and local requirements for container 
storage.) 

• Minimize contact with chemicals. Wear appropriate personal 
protective equipment when handling chemicals (for example, 
safety glasses, gloves, or protective clothing). For additional 
safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical 
containers open. Use only with adequate ventilation (for 
example, fume hood). For additional safety guidelines, consult 
the MSDS.

• Handle chemical wastes in a fume hood.
• After emptying the waste container, seal it with the cap 

provided.
• Dispose of the contents of the waste tray and waste bottle in 

accordance with good laboratory practices and local, 
state/provincial, or national environmental and health 
regulations.
Quantifiler® Duo DNA Quantification Kit User’s Manual ix
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Waste Disposal If potentially hazardous waste is generated when you operate the 
instrument, you must:

• Characterize (by analysis if necessary) the waste generated by 
the particular applications, reagents, and substrates used in your 
laboratory.

• Ensure the health and safety of all personnel in your laboratory.
• Ensure that the instrument waste is stored, transferred, 

transported, and disposed of according to all local, 
state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require 
special handling, and disposal limitations may apply.

Biological Hazard
Safety

BIOHAZARD. Biological samples such as 
tissues, body fluids, and blood of humans and other animals have the 
potential to transmit infectious diseases. Follow all applicable local, 
state/provincial, and/or national regulations. Wear appropriate 
protective eyewear, clothing, and gloves. Read and follow the 
guidelines in these publications:

• U.S. Department of Health and Human Services guidelines 
published in Biosafety in Microbiological and Biomedical 
Laboratories (stock no. 017-040-00547-4; 
http://bmbl.od.nih.gov)

• Occupational Safety and Health Standards, Bloodborne 
Pathogens
(29 CFR§1910.1030; http://www.access.gpo.gov/nara/cfr/ 
waisidx_01/29cfr1910a_01.html).

Additional information about biohazard guidelines is available at: 
http://www.cdc.gov
x Quantifiler® Duo DNA Quantification Kit User’s Manual
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How to Obtain More Information
How to Obtain More Information

Related
Documentation

• User Bulletin: ABI PRISM® 7000 Sequence Detection System 
and Applied Biosystems 7500 Real-Time PCR System: 
Instrument Calibration and Maintenance Procedures for Use 
with Quantifiler® DNA Quantification Kits (PN 4374416 Rev. A)

• User Bulletin: Quantifiler® Kits Validation Using SDS Software 
v1.2.3 on the Applied Biosystems 7500 Real-Time PCR System 
and the ABI PRISM® 7000 Sequence Detection System (PN 
4374659 Rev. B)

• Real-Time PCR Systems: Applied Biosystems 7900HT Fast 
Real-Time PCR System and 7300/7500 Real-Time PCR Systems 
Chemistry Guide (PN 4348358 Rev. E) 

Note: For additional documentation, see “How to Obtain Support” 
below.

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for 
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

How to Obtain Support
For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for 
Support.

At the Support page, you can:

• Obtain worldwide telephone and fax numbers to contact 
Applied Biosystems Technical Support and Sales facilities

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDSs, certificates 

of analysis, and other related documents 
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches
Quantifiler® Duo DNA Quantification Kit User’s Manual xi
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Chapter 1 Overview
Product Overview

Purpose The Quantifiler® Duo DNA Quantification Kit (PN 4387746) is 
designed to simultaneously quantify the total amount of amplifiable 
human DNA and human male DNA in a sample. The results obtained 
using the kit can aid in determining:

• If the sample contains sufficient human DNA and/or human 
male DNA to proceed with short tandem repeat (STR) analysis.

• The amount of sample to use in STR analysis applications.
• The relative quantities of human male and female DNA in a 

sample that can assist in the selection of the applicable STR 
chemistry.

• If PCR inhibitors are present in a sample that may require 
additional purification before proceeding to STR analysis.

Product
Description

The Quantifiler® Duo DNA Quantification Kit contains all the 
necessary reagents for the amplification, detection, and 
quantification of a human-specific DNA target and a human male-
specific DNA target.

The reagents are designed and optimized for use with the Applied 
Biosystems 7500 Real-Time PCR System and SDS Software v1.2.3.
1-2 Quantifiler® Duo DNA Quantification Kit User’s Manual



Chemistry Overview
Chemistry Overview

Assay Overview The DNA quantification assay combines three 5′ nuclease assays:

• A target-specific human DNA assay
• A target-specific human male DNA assay
• An internal PCR control (IPC) assay

Target-Specific
Assay

Components

The target-specific assays consist of:

• Two primers for amplifying human DNA 
• One TaqMan® MGB probe labeled with VIC® dye for detecting 

the amplified human target sequence
• Two primers for amplifying human male DNA
• One TaqMan® MGB probe labeled with FAM™ dye for 

detecting the human male amplified target sequence

About the Targets Table 1-1 provides information about the targets of PCR 
amplification in the Quantifiler® Duo DNA Quantification Kit.

IPC Assay
Components

The IPC assay consists of:

• IPC template DNA (a synthetic sequence not found in nature)
• Two primers for amplifying the 130 base IPC template DNA
• One TaqMan® MGB probe labeled with NED™ dye for 

detecting the amplified IPC DNA

Table 1-1 Quantifiler® Duo Kit targets

Target Gene Target Location Amplicon 
Length Gene ID Ploidy

 Human Target Ribonuclease P 
RNA Component 
H1 (RPPH1)

14q11.2 140 bases 85495 Diploid

Human Male Target Sex-determining 
region Y (SRY)

Yp11.3 130 bases 6736 Haploid
Quantifiler® Duo DNA Quantification Kit User’s Manual 1-3



Chapter 1 Overview
About the Probes The TaqMan® MGB probes contain:

• A reporter dye (FAM™, VIC® or NED™ dye) linked to the 
5′ end of the probe

• A minor groove binder (MGB) at the 3´ end of the probe
This modification increases the melting temperature (Tm) 
without increasing probe length (Afonina et al., 1997; Kutyavin 
et al., 1997), to allow for the design of shorter probes.

• A nonfluorescent quencher (NFQ) at the 3′ end of the probe 

5′ Nuclease
Assay Process

The 5′ nuclease assay process (Figures 1-1 through 1-5) takes place 
during PCR amplification. This process occurs in every cycle, and it 
does not interfere with the exponential accumulation of product.

Figure 1-1 Legend for 5′ nuclease assay process figures

During PCR, the TaqMan® MGB probe anneals specifically to a 
complementary sequence between the forward and reverse primer 
sites (Figure 1-2).

When the probe is intact (Figures 1-2 and 1-3), the proximity of the 
reporter dye to the quencher dye results in suppression of the reporter 
fluorescence primarily by Förster-type energy transfer (Förster, 1948; 
Lakowicz, 1983).

Figure 1-2 Polymerization
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Chemistry Overview
Figure 1-3 Strand displacement

AmpliTaq Gold® DNA polymerase cleaves only probes that are 
hybridized to the target (Figure 1-4). Cleavage separates the reporter 
dye from the quencher dye, resulting in increased fluorescence by the 
reporter. This increase in fluorescence signal occurs only if the target 
sequence is complementary to the probe and is amplified during 
PCR. Because of these requirements, nonspecific amplification is not 
detected.

Figure 1-4 Cleavage

Polymerization of the strand continues, but because the 3′ end of the 
probe is blocked, there is no extension of the probe during PCR 
(Figure 1-5).
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Chapter 1 Overview
Figure 1-5 Completion of polymerization

Human DNA
Standard

The human DNA used to generate the DNA quantification standards 
dilution series consists of pooled human male genomic DNA. As 
such, the performance of the Quantifiler® Duo assay is validated and 
the results are optimized for use with this DNA standard. The use of 
an alternate DNA standard may result in the reporting of different 
concentration values for the unknown samples. Use of an alternate 
DNA standard should be supported by appropriate validation studies.
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Primer

3′
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5′
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Primer

R

3′

TaqMan
MGB probe MGBNFQ
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Instrument Overview

Fluorescence
Detection

Detection on the Applied Biosystems 7500 Real-Time PCR 
System

1. A tungsten-halogen lamp directs light to each well on the 
reaction plate. The light excites the fluorescent dyes in each well 
of the plate.

2. During the run, the CCD camera detects the fluorescence 
emission.

3. The SDS software obtains the fluorescence emission data from 
the CCD camera and applies data analysis algorithms.

Figure 1-6 Applied Biosystems 7500 Real-Time PCR System
Quantifiler® Duo DNA Quantification Kit User’s Manual 1-7
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SDS Software Overview
The Applied Biosystems 7500 Real-Time PCR System is calibrated 
with several dyes including, FAM™, SYBR® Green, JOE™, VIC®, 
TAMRA™, NED™, CY3, ROX™, TEXAS RED and CY5.

The 7500 system uses the data obtained from the pure-dye calibration 
to distinguish the individual contribution of each dye in the collective 
fluorescence, as gathered by the instrument during a run. After each 
run, the SDS software receives raw spectra-signal data for each 
reading. To make sense of the raw data, the software determines the 
contribution of each fluorescent dye used in the sample by comparing 
the raw spectra data to a set of pure dye standards contained in the 
pure spectra file. When a plate is saved after analysis, the software 
stores the pure spectra information with the collected fluorescent data 
for that experiment. 

Figure 1-7 shows the emission spectrum for each dye, and the filters 
and wavelengths at which each dye is read.

Figure 1-7 Example of an emission spectrum
1-8 Quantifiler® Duo DNA Quantification Kit User’s Manual



Real-Time Data Analysis
Normalization of
Reporter Signals

The SDS software displays cycle-by-cycle changes in normalized 
reporter signal  (Rn). The SDS software normalizes each reporter 
signal by dividing it by the fluorescent signal of the passive reference 
dye. Because the passive reference is one component of the PCR 
master mix, it is present at the same concentration in all wells of the 
reaction plate. By normalizing the reporter signal using the passive 
reference, the software can account for minor variations in signal 
caused by pipetting inaccuracies and make better well-to-well 
comparisons of the reporter signal.

Real-Time Data Analysis
The 7500 Real-Time PCR instrument can be used to determine the 
relative quantity of a target nucleic acid sequence in a sample by 
analyzing the cycle-to-cycle change in fluorescent signal as a result 
of amplification (Figure 1-8).

Amplification Plot
Example

When using TaqMan® probes with the 7500 Real-Time PCR 
instrument, the fluorescent signal (or normalized reporter, Rn) 
increases as the amount of specific amplified product increases. 
Figure 1-8 shows the amplification of PCR product in a plot of Rn vs. 
cycle number during PCR. This amplification plot contains three 
distinct phases that characterize the progression of the PCR.
Quantifiler® Duo DNA Quantification Kit User’s Manual 1-9



Chapter 1 Overview
Figure 1-8 Phases of PCR amplification 

Phases of
Amplification

Initially, Rn appears as a flat line because the fluorescent signal is 
below the detection limit of the sequence detector.

Phase 1: Geometric (Exponential)

Upon detection, the signal increases in direct proportion to the 
increase of PCR product. As PCR product continues to increase, the 
ratio of AmpliTaq® Gold polymerase to PCR product decreases.

During the geometric phase, amplification is characterized by a high 
and constant efficiency. Amplification occurs between the first 
detectable rise in fluorescence and the beginning of the linear phase. 
During the geometric phase, a plot of DNA concentration versus 
cycle number on a log scale should approximate a straight line with a 
slope. Typically, the real-time PCR system is sufficiently sensitive to 
detect at least 3 cycles in the geometric phase, assuming reasonably 
optimized PCR conditions. 

Plateau
Phase

Linear
Phase

Geometric
Phase
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Real-Time Data Analysis
Phase 2: Linear 

During the linear phase, the slope of the amplification plot decreases 
steadily. At this point, one or more components of the PCR has 
decreased below a critical concentration, and the amplification 
efficiency begins to decrease. This phase is termed linear because 
amplification approximates an arithmetic progression, rather than a 
geometric increase. Because amplification efficiency is continually 
decreasing during the linear phase, the amplification curves exhibit 
low precision. 

Phase 3: Plateau

The amplification plot achieves the plateau phase when the PCR 
stops, the Rn signal remains relatively constant, and the template 
concentration reaches a plateau at about 10−7 M (Martens and Naes, 
1989).
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Chapter 1 Overview
Relationship of
Amplified PCR

Product to Initial
Template

Concentration

Because of the progressive cleavage of TaqMan® fluorescent probes 
during the PCR, as the concentration of amplified product increases 
in a sample, so does the Rn value. The following equation describes 
the relationship of amplified PCR product to initial template during 
the geometric phase:

where Nc is the concentration of amplified product at any cycle, N is 
the initial concentration of target template, E is the efficiency of the 
system, and c is the cycle number.

For example, with the dilutions of RNase P target in the TaqMan® 
RNase P Instrument Verification Plate, the ratio of template 
concentration to detectable signal is preserved in the geometric phase 
for all dilutions (Figure 1-9). As the rate of amplification approaches 
a plateau, the amount of product is no longer proportional to the 
initial number of template copies.

Figure 1-9 Amplification plot from a real-time run of an RNase P 
Instrument Verification Plate 
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Real-Time Data Analysis
About the
Threshold

The SDS software uses a threshold setting to define the level of 
detectable fluorescence. Based on the number of cycles required to 
reach the threshold, the SDS software can compare test samples 
quantitatively: A sample with a higher starting template copy number 
reaches the threshold earlier than a sample with a lower starting 
template copy number.

About the
Threshold Cycle

The threshold cycle (CT) for a specified amplification plot occurs 
when the fluorescent signal increases beyond the value of the 
threshold setting. The CT value depends on:

• Starting template copy number
• Efficiency of DNA amplification by the PCR system

How CT Values
Are Determined

To determine the CT value, the SDS software uses the Rn values 
collected from a predefined range of PCR cycles called the baseline 
(the default baseline occurs between cycles 3 and 15 on the 7500 
Real-Time PCR instrument):

1. The software generates a baseline-subtracted amplification plot 
of ΔRn versus cycle number.

2. An algorithm defines the cycle where the ΔRn value crosses the 
threshold setting as the threshold cycle (CT).

Relationship of
Threshold Cycles
to Initial Template

Amount

The following equation describes the exponential amplification of 
the PCR:

where:

Xn = number of target molecules at cycle n (so that n > m)

Xm = number of target molecules at cycle m

EX = efficiency of target amplification (between 0 and 1)

n − m = number of cycles elapsed between cycle m and cycle n

Xn Xm 1 EX+( )n m–
=
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Chapter 1 Overview
Amplicons designed and optimized according to Applied Biosystems 
guidelines (amplicon size <150 bp) have amplification efficiencies 
that approach 100%. Therefore EX = 1 so that:

To define the significance in amplified product of one thermal cycle, 
set n − m = 1 so that:

Therefore, each cycle in the PCR reaction corresponds to a two-fold 
increase in product. Likewise, a difference in CT values of 1 equates 
to a two-fold difference in initial template amount.

Xn Xm 1 1+( )n m–
=

Xm 2( )n m–=

Xn Xm 2( )1
=

2Xm=
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Quantifiler® Duo Kit Workflow
Quantifiler® Duo Kit Workflow
Use of the Quantifiler® Duo Kit involves the following workflow:

Software Setup

PCR Amplification

Data Analysis

Interpretation of Results
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Chapter 1 Overview
Materials and Equipment

Kit Contents and
Storage

Each Quantifiler® Duo DNA Quantification Kit contains materials 
sufficient to perform 400 reactions at a 25-µL reaction volume. Store 
the entire kit at −15 °C to −25 °C upon receipt. Store the kit at 2°C to 
8°C after first thaw, as described in Table 1-2. 

Table 1-2  Quantifiler® Duo DNA Quantification Kit contents

Reagent Contents Quantity Storage

Quantifiler® Duo Primer Mix • Primer pairs for 
amplification of 
RPPH1, SRY and IPC.

• TaqMan® probes for 
RPPH1, SRY and IPC, 
which are labeled with 
VIC® , FAM™ and 
NED™ dyes, 
respectively. 

• IPC template.

3 tubes, 
1.4 mL 
each

2 to 8 °C

(keep 
protected from 

exposure to 
light)

Quantifiler® Duo PCR Reaction Mix • MgCl2, dNTPs, bovine 
serum albumin, and 
AmpliTaq Gold® DNA 
Polymerase in buffer 
and salts. 

• Sodium azide (0.02% 
w/v) is incorporated as 
preservative.

1 Tube,

 5.0 mL

2 to 8 °C 
(keep 

protected from 
exposure to 

light)

Quantifiler® Duo DNA Standard Human male genomic 
DNA.

1 tube, 
120 µL

2 to 8 °C 

Quantifiler® Duo DNA Dilution Buffer 10 mM Tris HCl buffer pH 
8.0 containing 0.1 mM 
EDTA.

2 Tubes,

 1.8 mL 
each

2 to 8 °C
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Materials and Equipment
Additional
Storage Guideline

For Primer Mix
and PCR

Reaction Mix

Keep Primer Mix and PCR Reaction Mix protected from direct 
exposure to light. Excessive exposure to light may affect the 
fluorescent probes and/or the passive reference dye.

Equipment and
Materials Not

Included

Tables 1-3 through 1-5 list required and optional equipment and 
materials not supplied with the Quantifiler® Duo DNA 
Quantification Kit. Unless otherwise noted, many of the items are 
available from major laboratory suppliers (MLS).

Table 1-3 Equipment not included

Equipment Source

Applied Biosystems 7500 Real-Time PCR 
Instrument

Contact your local 
Applied Biosystems 
sales representative

Tabletop centrifuge with 96-well plate 
adapters (optional)

MLS

Table 1-4 User-supplied materials

Material Source

Quantifiler® Duo DNA Quantification Kit Applied Biosystems 
(PN 4387746)

High-Throughput Setup

MicroAmp® Optical 96-Well Reaction Plate 
with Barcode

Applied Biosystems 
(PN 4306737)

MicroAmp® Optical Adhesive Film Applied Biosystems 
(PN 4311971)

MicroAmp® Splash Free 96-Well Base Applied Biosystems 
(PN 4312063)
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Chapter 1 Overview
Mid-to-Low-Throughput Setup

MicroAmp® Optical 8-Tube Strip (8 
tubes/strip, 125 strips)

Applied Biosystems 
(PN 4316567)

MicroAmp® 96-Well Tray/Retainer Set Applied Biosystems 
(PN 403081)

MicroAmp® Optical 8-Cap Strip (8 tubes/strip, 
125 strips)

Applied Biosystems 
(PN 4323032)

Table 1-5 Documents

Document Applied Biosystems 
Part Number

Real-Time PCR Systems: Applied Biosystems 
7900HT Fast Real-Time PCR System and 
7300/7500 Real-Time PCR Systems: Rev E 

 4348358E

Table 1-4 User-supplied materials (continued)

Material Source
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Chapter 2 Software Setup
Overview

Purpose During software setup, you start up the 7500 Real-Time PCR System 
and set up a plate document for DNA quantification using the 
Quantifiler® Duo DNA Quantification Kit.

Configuration The Quantifiler® Duo DNA Quantification Kit is supported using the 
7500 Real-Time PCR System with SDS Software v1.2.3 for real-time 
data collection and analysis.
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Starting the 7500 Real-Time PCR System
Starting the 7500 Real-Time PCR System

Overview Starting the 7500 Real-Time PCR System involves:

1. Starting the Computer (page 2-3)

2. Powering On the Instrument (page 2-3)

3. Starting the 7500 SDS Software (page 2-5)

Starting the
Computer

Powering On the
Instrument

Note: Wait for the computer to finish starting up before powering on 
the 7500 instrument.

PHYSICAL INJURY HAZARD. Moving parts 
can crush and cut. Keep hands clear of moving parts while operating. 
Disconnect power before servicing the instrument.

1. If you are using the laptop computer, open it by pushing in 
the front, center button, holding it, and lifting up the lid.

2. Press the power button on the computer. 

3. In the Enter User name field of the login window, type your 
name or the user name associated with the computer, if 
applicable.

4. If required, type your password in the Password field.

Laptop Power button
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Chapter 2 Software Setup
Press the power button on the lower right front of the 7500 
instrument. 

• The indicator lights on the lower left of the front panel cycle 
through a power on sequence.

• When the green power indicator is lit (not flashing), 
communication is established between the computer and the 
instrument.

If the green power-on indicator is flashing or the red error indicator is 
lit, see the Applied Biosystems 7300/7500/7500 Fast Real-Time PCR 
System Installation and Maintenance Guide (PN 4347828).

Power button

Indicator lights
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Starting the 7500 Real-Time PCR System
Starting the 7500
SDS Software

Select Start > 7500 System > 7500 System Software. 

The first time you use the software, the Product Registration window 
displays and you are prompted to register the product. 

Enter your name, organization, registration code, then click OK. On 
subsequent start ups, if the Product Registration window displays, 
click Cancel. 

The software starts and displays the word “Disconnected” in the 
status bar on the bottom-right corner. The status changes to 
“Connected” only after the New Document Wizard is completed, the 
software is initialized, and the software is connected to the 7500 
instrument. If the connection is successful, the software displays 

 in the status bar on the bottom-right corner.
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About Plate Documents

How Plate
Documents Are

Used

Running a reaction plate on the 7500 system requires creating and 
setting up a plate document using the 7500 SDS software. A plate 
document is a representation of the arrangement of samples 
(standards and unknowns) and reagents on the reaction plate. The 
7500 SDS software uses the plate document to:

• Coordinate the instrument operation, such as thermal cycling 
and data collection

• Organize and store the data gathered during the run
• Analyze the data from the run

Plate Document
Types

You can use the SDS software to create two types of plate document 
files.

Table 2-1 Plate Documents

Plate Document Type File Extension Description

SDS document *.sds Primary file to use when performing a run. Required for 
all experiments.

SDS template *.sdt File that already contains run parameters that are 
commonly used in plate documents, such as detectors, 
thermal cycler conditions, and so on. Streamlines the 
creation of the SDS document (*.sds) file.
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About Plate Documents
Example Plate
Document Setup

You can arrange the reactions in any well of the reaction plate, but set 
up the plate document so that it corresponds exactly to the 
arrangement of the standards and unknown samples in the wells of 
the reaction plate.

Table 2-2 shows one example of arranging reactions. 

Note: For each Quantifiler® Duo DNA Quantification Kit assay, 
there are eight DNA quantification standards and two reactions for 
each standard. See “Preparing the DNA Quantification Standards” on 
page 3-2 for more information about the DNA quantification 
standards

.

Table 2-2 Example plate setup of reactions (UNKN=unknown, NTC=non-template control)

1 2 3 4 5 6 7 8 9 10 11 12

A Std 1 Std 1 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

B Std 2 Std 2 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

C Std 3 Std 3 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

D Std 4 Std 4 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

E Std 5 Std 5 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

F Std 6 Std 6 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

G Std 7 Std 7 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN

H Std 8 Std 8 UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN UNKN NTC
Quantifiler® Duo DNA Quantification Kit User’s Manual 2-7



Chapter 2 Software Setup
Setting Up a Plate Document 

Overview Setting up a plate document to run the Quantifiler® Duo DNA 
Quantification Kit assay involves:

1. Creating a Blank Plate Document (page 2-9)

2. Creating Detectors (page 2-10)

3. Adding Detectors to the Plate Document (page 2-15)

4. Adding Detectors to an Open Plate Document (Alternative) 
(page 2-19)

5. Assigning Sample Name, Task, and Quantity to Standards 
(page 2-20)

6. Assigning Sample Name and Task to Unknown Samples and 
Non-Template Controls (page 2-22)

7. Setting Thermal Cycler Conditions (page 2-24)

8. Saving the Plate Document and Starting the Run (page 2-25)
2-8 Quantifiler® Duo DNA Quantification Kit User’s Manual



Setting Up a Plate Document
Creating a Blank
Plate Document

To create a blank plate document: 

1. If the 7500 SDS software is not already started, select Start 
> Programs > 7500 System > 7500 System Software. You 
can also launch the software from the shortcut on your 
desktop by double-clicking the icon.

2. In the 7500 SDS software, select File > New to open the 
New Document Wizard - Define Document window. The 
default settings are shown.
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Chapter 2 Software Setup
Creating
Detectors

The first time you run the Quantifiler® Duo DNA Quantification Kit 
assay you must create three detectors in the 7500 SDS Software. 

There are two methods for creating these detectors. 

• You can create the detectors upon first run from the New 
Document Wizard Select Detector Window,
or 

• You can create the detectors from an open plate document. 

Both methods are explained below.

After you create these detectors, you do not need to create any others 
for subsequent runs of the Quantifiler® Duo DNA Quantification Kit 
assays. Upon completion, proceed to “Adding Detectors to the Plate 
Document” on page 2-15.

3.  Use the default settings shown, then click Next to display 
the Select Detectors window. 

Note: If detector names are not listed (first-time use), add 
new detectors as described in the following section.

To create a blank plate document:  (continued)
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Setting Up a Plate Document
To create detectors:

1. Open the New Detector dialog box:
• From the Document Wizard - Select Detectors window, 

click New Detector to open the New Detector dialog 
box.
or

• From an open plate document, select Tools > Detector 
Manager to open the Detector Manager.

• Then, in the Detector Manager window, select File > 
New to open the New Detector dialog box.
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Chapter 2 Software Setup
2. In the New Detector dialog box, create a detector for the 
RPPH1 human target: 

a. Enter Duo Human in the name field.

b. Select VIC for the Reporter Dye.

c. Select (none) for the Quencher Dye.

d. Click and select a color.

IMPORTANT! Make sure that you select the VIC dye for 
Duo Human.

3. Click Create Another to add Duo Human to the Detector 
Name list, and to reset the New Detector dialog box.

To create detectors: (continued)

Enter Duo Human

Select VIC
Select (none) 

Click to select a color
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Setting Up a Plate Document
4. Create a detector for the SRY Male target: 

a. Enter Duo Male in the name field.

b. Select FAM for the Reporter Dye.

c. Select (none) for the Quencher Dye.

d. Click and select a color.

IMPORTANT! Make sure that you select the FAM dye for 
Duo Male.

5. Click Create Another to add Duo Male to the Detector 
Name list, and to reset the New Detector dialog box.

To create detectors: (continued)

Enter Duo Male

Select FAM

Select (none) 

Click to select a color
Quantifiler® Duo DNA Quantification Kit User’s Manual 2-13
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6. Create a detector for the IPC target: 

a. Enter Duo IPC in the name field.

b. Select NED for the Reporter Dye.

c. Select (none) for the Quencher Dye.

d. Click and select a color.

IMPORTANT! Make sure that you select the NED dye for 
Duo IPC.

To create detectors: (continued)

Enter Duo IPC

Select NED
Select (none) 

Click to select a color
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Setting Up a Plate Document
When you are finished, add detectors to the plate document.

IMPORTANT! Make sure that the appropriate reporter dye is selected 
for the three detectors: VIC® for Duo Human, FAM™ for Duo Male 
and NED™ for Duo IPC. 

Adding Detectors
to the Plate
Document

There are two methods for adding detectors:

• You can add the detectors from the New Document Wizard - 
Select Detector Window,
or

• You can add the detectors from an open plate document.

Both methods are explained below.

7. Click OK to add Duo IPC to the Detector Name list, and to 
return to the Select Detectors window.

To create detectors: (continued)
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To add detectors to the plate document:

1. In the New Document Wizard - Select Detectors window, 
Ctrl-click the Duo Human, Duo Male and Duo IPC 
detectors. If the detectors for the Duo DNA Quantification 
Kit are not listed in the Detector Name field, see the Creating 
Detectors section (page 2-10).

2.  Select ROX as the Passive Reference and click Add to add 
the detectors to the Detectors in Document list.

3. Click Next to continue to the Set Up Sample Plate window.

Select ROX

Add the 
detectors to 
the Plate 
Document
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Setting Up a Plate Document
4. In the Set Up Sample Plate window, select wells and 
detectors to apply: 

• Ctrl-click all wells containing quantification standards, 
unknown samples and Non-Template Control (shown in 
color). 

• Check all three detectors listed in the Use column (Duo 
Human, Duo Male and Duo IPC)

IMPORTANT! Apply all three detectors to the plate 
document for all the wells that contain Quantifiler® Duo 
DNA Quantification Kit assay reagents.

5. Click Finish in the New Document Wizard - Set Up Sample 
Plate window to complete the New Document Wizard and to 
be automatically directed to the Plate Setup tab. 

The 7500 System Software initializes and connects to the 
7500 instrument. If the connection is successful,  
displays in the bottom-right corner status bar.

To add detectors to the plate document: (continued)

All wells are 
selected

Check all 3 detectors listed
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Chapter 2 Software Setup
When you are finished, in the 7500 System Software Plate - Setup tab 
(Figure 2-1) assign sample names, tasks, and quantities to standards 
as necessary (see page 2-20 for procedure).

Figure 2-1 7500 System Software Plate - Setup tab
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Setting Up a Plate Document
Adding Detectors
to an Open Plate

Document
(Alternative)

When you are finished, in the 7500 System Software Plate - Setup tab 
(shown previously in Figure 2-1) assign sample names, tasks, and 
quantities to standards as necessary (see page 2-20 for procedure).

To alternatively add detectors to an open plate document:

1. Within an open plate document, select Tools > Detector 
Manager to open the Detector Manager window.

2. In the Detector Manager window, Ctrl-click the Duo 
Human, Duo Male and Duo IPC detectors, then click Add 
to plate Document.

If the detectors for the Duo DNA Quantification Kit are not 
listed in the Detector Name field, see “Creating Detectors” 
on page 2-10.

3. Click Done to close the Detector Manager.

Add the detectors to 
the plate document
Quantifiler® Duo DNA Quantification Kit User’s Manual 2-19



Chapter 2 Software Setup
Assigning Sample
Name, Task, and

Quantity to
Standards

IMPORTANT! Assign Sample Name, Task and Quantity parameters 
for each quantity separately. For example, assign the parameters for 
quantification standard 1, and then for quantification standard 2, and 
so on, until you finish assigning the parameters for all wells 
containing quantification standards  

To apply parameters to quantification standards:

1. In the Plate Setup tab, select wells that correspond to a 
specific quantification standard for the Duo DNA 
Quantification Kit (e.g. Std. 1).

2. With the wells selected, click View > Well Inspector 
(or Ctrl-double click the wells) to open the Well Inspector 
dialog box. 

Note: The Well Inspector displays the detectors that were 
added to the plate document.

Selected wells
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Setting Up a Plate Document
When you are finished, assign sample names, tasks, and quantities to 
unknown samples and non-template controls, as necessary.

3. Complete the fields in the Well Inspector dialog box:

a. For the Duo Human and Duo Male detectors, click 
Unknown in the Task column, then select Standard from 
the drop-down list.

b. For the Duo Human and Duo Male detectors, select the 
Quantity field and enter the appropriate quantity of 
DNA in the well expressed in ng/µL for both detectors 
(e.g. enter 50 for Std. 1 for both Duo Human and Duo 
Male detectors).

c. Enter the Sample Name (e.g. Std. 1, Std. 2, and so on).

d. For the Duo IPC detector, keep the default Task as 
Unknown.

Note: Make sure that ROX is selected as Passive Reference.

4. Click Close to close the dialog box.

To apply parameters to quantification standards: (continued)

Sample 
Name, 
Task and 
Quantity

Select 
ROX 
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Assigning Sample
Name and Task to

Unknown
Samples and

Non-Template
Controls

To assign parameters to unknown samples and non-template 
control (NTC) wells:

1. In the Plate Setup tab, select the wells that correspond to an 
unknown sample or NTC for the Duo DNA Quantification 
Kit.

2. With the well(s) selected, select View > Well Inspector (or 
Ctrl-double click) to open the Well Inspector dialog box. 

The Well Inspector displays the detectors that were added to 
the plate document.

Selected well
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Setting Up a Plate Document
3. Enter the parameters:

a. In the Task column, keep the default “Unknown” for all 
three detectors. 

b. Enter the Sample Name (for example, Unknown 1 for 
unknown samples and NTC for NTC wells).

Note: For the Passive Reference, select ROX.

Example: Unknown samples.

Example: NTC Wells.

Note: Samples with identical sample names are treated as 
replicates by the 7500 System Software. Results for replicate 
reactions are grouped together automatically for data 
analysis.

 4. Click Close to close the Well Inspector window.

To assign parameters to unknown samples and non-template 
control (NTC) wells: (continued)

Task for all 3 detectors set to Unknown.

Task for all 3 detectors set to Unknown.
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When you are finished assigning all parameters, set the thermal 
cycler conditions, as described in the following section.

Setting Thermal
Cycler Conditions

Before running a Duo DNA Quantification Kit assay, set the thermal 
cycler conditions by changing the default thermal cycler Sample 
Volume.

To set thermal cycler conditions:

1. In the plate document, select the Instrument tab.

2. Change the Sample Volume to 25 (µL) and select the 9600 
Emulation box.

Note: Selecting the 9600 Emulation box reduces the ramp 
rate. 

Note: The thermal cycler protocol validated for use with the 
Quantifiler® Duo kit includes a hold step at 50 °C for 2 
minutes.  This step was deleted from the Quantifiler® 
Human and Quantifiler® Y Human Male Kit Thermal Cycler 
Protocol.

Select 
this box

Set the volume to 25 µL
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Setting Up a Plate Document
When you are finished, save the plate document and start the run, as 
described in the following section.

Saving the Plate
Document and

Starting the Run

Before running the reaction plate, save the plate document as an SDS 
Document (*.sds) file.

Note: To save the plate document as a template, see “Setting Up a 
Plate Document Template” on page 2-26.

To save the plate document and start the run:

1. Select File > Save.

2. Select the location for the plate document.

3. Enter a file name.

4. For Save as type, select SDS Documents (*.sds).

5. Click Save, then Start to start the run.
Quantifiler® Duo DNA Quantification Kit User’s Manual 2-25



Chapter 2 Software Setup
Setting Up a Plate Document Template

Purpose A plate document template reduces the time required to set up a plate 
document. This section describes how to create an SDS Template 
Document (*.sdt) for running the Quantifiler® Duo DNA 
Quantification Kit assays.

Template Settings In addition to plate document settings (assay and container), 
templates can contain:

• Assay-specific detectors
• Well assignments for quantification standards, with detectors, 

tasks, and quantity
• Well assignments for unknown samples, with detectors and tasks
• Instrument settings: reaction volume settings and 9600 

Emulation setting

Creating a Plate
Document

Template

This procedure assumes that you have created the detectors for 
running reactions using the Duo DNA Quantification Kit 
(page 2-10).

To create a plate document template:

1. If the 7500 SDS Software is not already started, select Start 
> Programs > 7500 System> 7500 System Software.

2. Select File > New to open the New Document Wizard - 
Define Document window, then click Next.
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Setting Up a Plate Document Template
3. Apply the applicable template settings to the plate document:
• Add detectors to the plate document (page 2-15).
• Apply detectors and assign sample name, task, and 

quantity to standards, unknown samples, and NTC wells 
(page 2-20 and page 2-22).

• Set thermal cycler conditions (page 2-24).

4. Select File > Save As and complete the Save As dialog box:

a. For Save as type, select SDS Templates (*.sdt).

b. Locate and select the Templates folder within the 
software folder:
X:Program Files > 7500 System > Templates, where 
X is the hard drive on which the 7500 System SDS 
software is installed.

Note: Saving the template file in the Templates folder 
makes the template available in the Template drop-
down list of the New Document Wizard - Define 
Document window (see step 2 in “Creating a Plate 
Document from a Template” on page 2-28).

c. For File name, enter a name for the template. For 
example, enter Duo Template: 

d. Click Save.

To create a plate document template: (continued)

Save the template file in the Templates folder

Save as (*.sdt) 
template type
Quantifiler® Duo DNA Quantification Kit User’s Manual 2-27



Chapter 2 Software Setup
Creating a Plate
Document from a

Template

After you create a template, you can use it to create a plate document.

To create a plate document from a template:

1. If the SDS software is not already started, select Start > 
Programs > 7500 System > 7500 System Software.

2. Select File > New to open the New Document Wizard - 
Define Document window and make the following 
selections:

• For Assay, select Absolute Quantitation.
• For Container, select 96-Well Clear.
• For Template, select an applicable template from the 

list.

Note: If the template is not available in the list, click Browse 
to locate and select an applicable template.

3. Click Finish and go to the Plate Setup tab.

4. If the template doesn't contain all the information you need, 
complete the plate document as follows:

• Add detectors to the plate document using the open 
plate alternative method (page 2-19)

• Apply detectors and assign sample name, task, and 
quantity to standards, unknown samples, and NTC wells 
(page 2-20 and page 2-22)

• Set thermal cycler conditions (page 2-24)

Note: The tasks that you perform at this stage vary 
according to which settings were defined in the template.

5. Save the plate document (page 2-25).

Note: For Save as type, select SDS Documents (*.sds).
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Chapter 3 PCR Amplification
Preparing the DNA Quantification Standards

Required
Materials

The required materials include:

• Pipettors
• Pipette tips
• Microfuge tubes
• Quantifiler® Duo DNA Standard
• Quantifiler® Duo DNA Dilution Buffer

Note: You can store the diluted DNA quantification standards for up 
to 2 weeks at 2 to 8 °C. Longer term storage is not recommended.

Guidelines for
Calculating the

Standards
Dilution Series

The standard dilution series example shown in Table 3-1 on page 3-3 
is suitable for general use. 

IMPORTANT! Applied Biosystems recommends:

• Three-fold dilution series with eight concentration points in the 
standard series 

• Minimum input volume of 10 µL DNA for dilutions (to ensure 
accuracy of pipetting)
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Standards
Dilution Series

Example

Table 3-1 shows an example of one standards dilution series with the 
concentrations ranging from 50 ng/µL (Std. 1) to 0.023 ng/µL, or 
23 pg/µL (Std. 8). When 2.0 µL of a sample at the lowest 
concentration (23 pg/µL) is loaded in a reaction, the well contains 
approximately 7 diploid human genome equivalents. These 
equivalents correspond to approximately 14 copies of the Duo 
Human target locus and approximately 7 copies of the Duo Male 
target locus (Y chromosome loci are haploid).

Table 3-1 Standards dilution series example

Standard Concentration 
(ng/µL) Example Amounts Minimum Amounts Dilution 

Factor

Std. 1 50.000 50 µL [200 ng/µL stock] + 
150 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [200 ng/µL stock] + 
30 µL Quantifiler® Duo 
DNA dilution buffer

4✕

Std. 2 16.700 50 µL [Std. 1] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 1] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕

Std. 3 5.560 50 µL [Std. 2] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 2] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕

Std. 4 1.850 50 µL [Std. 3] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 3] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕

Std. 5 0.620 50 µL [Std. 4] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 4] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕

Std. 6 0.210 50 µL [Std. 5] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 5] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕

Std. 7 0.068 50 µL [Std. 6] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 6] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕

Std. 8 0.023 50 µL [Std. 7] +
100 µL Quantifiler® Duo 
DNA dilution buffer

10 µL [Std. 7] +
20 µL Quantifiler® Duo 
DNA dilution buffer

3✕
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Preparation
Guidelines

While preparing the standards, keep in mind that:

• DNA quantification standards are critical for accurate analysis 
of run data

• Mistakes or inaccuracies in making the dilutions directly affect 
the quality of results

• The quality of pipettors and tips and the care used in measuring 
and mixing dilutions affect accuracy

Preparing the
DNA

Quantification
Standards

When using Quantifiler® Duo DNA Dilution Buffer, you can store 
the prepared DNA quantification standards for up to 2 weeks at 
2 to 8 °C.

To prepare the DNA quantification standards dilution series:

1. Label eight microcentrifuge tubes: Std. 1, Std. 2, Std. 3, and 
so on.

2. Dispense the required amount of diluent (Quantifiler® Duo 
DNA Dilution Buffer) to each tube (refer to Table 3-1 for 
volumes).

3. Prepare Std. 1:

a. Vortex the Quantifiler® Duo DNA Standard 
3 to 5 seconds.

b. Using a new pipette tip, add the calculated amount of 
Quantifiler® Duo DNA Standard to the tube for Std. 1.

c. Mix the dilution thoroughly.

4. Prepare Std. 2 through 8:

a. Using a new pipette tip, add the calculated amount of 
the prepared standard to the tube for the next standard 
(refer to Table 3-1 for volumes).

b. Mix the standard thoroughly.

c. Repeat steps 4a and 4b until you complete the dilution 
series.
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Preparing the Reactions

Required
Materials

• Quantifiler® Duo Primer Mix
• Quantifiler® Duo PCR Reaction Mix
• 10-mL polypropylene tube
• 96-well reaction plate
• Extracted DNA samples
• DNA quantification standards dilutions series
• Optical adhesive cover

Preparing the
Reactions

While preparing the reactions, keep the 96-well reaction plate in its 
base and do not place it directly on the bench top to protect it from 
scratches and particulate matter.

To prepare the reactions:

1. Calculate the volume of each component needed to prepare 
the reactions, using the table below.

Note: Include additional reactions in your calculations to 
provide excess volume for the loss that occurs during reagent 
transfers.

CHEMICAL HAZARD. Quantifiler® 
Duo PCR Reaction Mix may cause eye and skin irritation. 
Exposure may cause discomfort if swallowed or inhaled. 
Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Component Volume Per 
Reaction (µL)

Quantifiler® Duo Primer Mix 10.5

Quantifiler® Duo PCR Reaction Mix 12.5
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2. Prepare the reagents:
• Thaw the Quantifiler® Duo Primer Mix completely, 

then vortex 3 to 5 seconds and centrifuge briefly before 
opening the tube.

• Swirl the Quantifiler® Duo PCR Reaction Mix gently 
before using. Do not vortex it.

3. Pipette the required volumes of components into an 
appropriately sized polypropylene tube.

4. Vortex the PCR mix 3 to 5 seconds, then centrifuge briefly.

5. Dispense 23 µL of the PCR mix into each reaction well.

6. Add 2 µL of sample, standard, or control to the applicable 
wells. For a plate setup example, see page 2-7.

IMPORTANT! Applied Biosystems recommends running 
duplicates of the eight DNA quantification standards for 
each reaction plate.

7. Seal the reaction plate with the Optical Adhesive Cover.

8. Centrifuge the plate at 3000 rpm for about 20 seconds in a 
tabletop centrifuge with plate holders to remove any bubbles.

Note: If a tabletop centrifuge with 96-well plate adapters is 
not available, visually inspect the plate for bubbles, and 
lightly tap the plate to remove bubbles in wells.

To prepare the reactions: (continued)
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Running the Reactions 

Before You Run
the Reactions

Before you run the reactions, make sure that you have:

• Powered on the 7500 Real-Time PCR instrument, computer, and 
software. For setup procedures, see page 2-3.

• Set up a plate document for the run. See page 2-7.

Running the Plate
on the 7500 Real-

Time PCR
Instrument

To run the plate on the 7500 Real-Time PCR instrument:

1. Press the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure 
that the plate is correctly aligned in the holder.
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3. Load standard 96-well plates with the notched A12 position 
at the top-right of the tray.

4. Close the tray door. 

To run the plate on the 7500 Real-Time PCR instrument: 
(continued)

12

Well A1
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5. Apply pressure to the right side of the tray and at an angle to 
close the tray door.

6. In the 7500 SDS software, open the plate document that you 
set up for the run.

7. Select the Instrument tab, then click Start.

To run the plate on the 7500 Real-Time PCR instrument: 
(continued)

Press forward 
here at slight right 
angle.
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Chapter 4 Data Analysis and Results
Analyzing the Plate Document 
Analyze a run after it is complete and reanalyze after you make any 
changes to the plate document, such as sample names.

To analyze a plate document:

1. To open the plate document for analysis: 
• Navigate to the folder where the run file is stored, and 

double-click the run file. 
or

• Launch the software from the shortcut on your desktop: 
• Double-click the 7500 System Software icon, 
• Click File > Open, 

• Then select the run file and click Open (or double-
click the run file).
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2. Verify the analysis settings:

a. On the menu bar, select Analysis > Analysis Settings 
to open the Analysis Settings dialog box.

b. Verify that the settings are as shown below, then click 
OK.

IMPORTANT! If the analysis settings differ from those 
shown here, change them to match the settings, then click 
OK.

3. On the menu bar, select Analysis > Analyze.

Note: For routine analysis that doesn't require any change in 
the Analysis Settings and to skip all the steps described 
above, click the green arrow on the system software tool bar.

To analyze a plate document: (continued)
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Viewing Results

Overview Viewing the results of data analysis can involve one or more of the 
following:

• Viewing the Standard Curve (page 4-4)
• Viewing the Amplification Plot (page 4-6)
• Viewing the Report (page 4-6)
• Exporting the Results (page 4-8)

Viewing the
Standard Curve

For information about interpreting and troubleshooting the standard 
curve, see “Examining the Standard Curve” on page 5-3 and 
“Troubleshooting the Standard Curve” on page 5-5.

To view the standard curve: 

1. In the Results tab, select the Standard Curve tab.

2. In the Detector drop-down list, select the applicable detector:
• Duo Human or

• Duo Male

3. View the CT values for the quantification standard reactions 
and the calculated regression line, slope, y-intercept, and R2 
values.
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Amplification Plot
Results

The amplification plot can display one of the following:

• Plot of normalized reporter signal (Rn) versus cycle (log) view 
• CT versus well position view
• Plot of normalized reporter signal (Rn) versus cycle (linear 

view)

For more information about the amplification plot, see “Real-Time 
Data Analysis” on page 1-9 or the Applied Biosystems 
7300/7500/7500 Fast Real-Time PCR System Absolute 
Quantification Getting Started Guide (PN 4378658).

4. In the Detector drop-down list, select ALL to view both 
standard curves at the same time. Only CT values can be 
viewed with this selection.

Note: The figure below shows an example of the standard 
curve plots. The gap between the Duo Human and the Duo 
Male CT values may vary depending on the relative slopes of 
the two targets and instrument performance.

To view the standard curve:  (continued)

Duo Human

Duo Male
Quantifiler® Duo DNA Quantification Kit User’s Manual 4-5



Chapter 4 Data Analysis and Results
Viewing the
Amplification Plot

For troubleshooting information, see “Troubleshooting Amplification 
Plots” on page 5-15.

Viewing the
Report

The report displays data for selected wells in tabular form and 
summarizes the quantity of DNA present in the samples. For 
information about the quantities reported, see “Assessing Quantity” 
on page 5-19.

To view the amplification plot:

1. In the Results tab, select the Amplification Plot tab.

2. In the Detector drop-down list, select a detector:
• Duo Human
• Duo Male
• IPC

3. Select the applicable samples in the table below the 
amplification plot.

4. Make sure that the Threshold is set to 0.20, the default 
setting.

Note: If you move the threshold bar, it changes from green 
to red to indicate that reanalysis is needed. After reanalysis, 
it changes from red back to green.

To view the report: 

1. In the analyzed plate document, select the Results tab, then 
select the Report tab.

2. Select the reactions in the 96-well plate representation below 
the report to display the results in the report.
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3. View the Qty column to determine the quantity of DNA in 
each sample.

Note: The values in the Qty column are calculated by 
interpolation from the standard curve for a given sample. 
Quantities are calculated only if quantification standards 
were run and set up correctly in the software. Otherwise, 
only CT values are shown.

Note: Go to Tools > Report Settings to format the report 
for printing. Refer to the Online Help for more information 
about the Report Settings dialog box.

To view the report:  (continued)
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Exporting the
Results

You can export numeric data into text files, which can then be 
imported into spreadsheet applications such as Microsoft Excel®.

To export the results:

1. In the analyzed plate document, select File >Export, then 
select the data type to export:

• Sample Setup (*.txt)
• Calibration Data (*.csv)
• Spectra (*.csv)
• Component (*.csv)
• Delta Rn (*.csv)
• CT (*.csv)
• Dissociation (*.csv)

• Results

2. Enter a file name for the export file and click Save.

For more information about exporting data, see the Applied 
Biosystems 7300/7500/7500 Fast Real-Time PCR System 
Absolute Quantification Getting Started Guide 
(PN 4378658).
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Checking Analysis Settings
The validity of the results requires correct analysis settings. 

Checking
Analysis Settings
on the 7500 SDS

To check analysis settings on the 7500 SDS:

1. If the SDS software is not already started, select Start > 
Programs > 7500 System> 7500 System Software.

2. Select File > Open.

3. Locate the plate document for the assay run of interest, select 
it, then click Open. Alternatively, navigate to the folder 
containing the run file and double-click the run file to skip 
the previous steps.

4. Select Analysis > Analysis Settings.

5. For all detectors, confirm that the settings are set as shown:
• Select All Detectors. 
• Select Manual Ct and enter 0.2 as the Threshold.
• Select Manual Baseline and enter 3 to 15 as cycle 

range.

If the analysis settings differ from those shown, set as noted 
above and click Apply, then click OK & Reanalyze to 
reanalyze and close the plate document. View the results 
using Chapter 4, “Data Analysis and Results.”
5-2 Quantifiler® Duo DNA Quantification Kit User’s Manual



Examining the Standard Curve
Examining the Standard Curve
Examine the standard curve results to evaluate the quality of the 
results from the quantification standard reactions.

About Standard
Curve Results

The standard curve is a graph of the CT of quantification standard 
reactions plotted against the starting quantity of the standards. The 
software calculates the regression line by calculating the best fit with 
the quantification standard data points. The regression line formula 
has the form:

CT = m [log (Qty)] + b

where m is the slope, b is the y-intercept, and Qty is the starting 
DNA quantity. The values associated with the regression analysis can 
be interpreted as follows:

• R2 value – Measure of the closeness of fit between the standard 
curve regression line and the individual CT data points of 
quantification standard reactions. A value of 1.00 indicates a 
perfect fit between the regression line and the data points.

• Regression coefficients:
– Slope – Indicates the PCR amplification efficiency for the 

assay. A slope of −3.3 indicates 100% amplification 
efficiency.

– Y-intercept – Indicates the expected CT value for a sample 
with Qty = 1 (for example, 1 ng/µL).

R2 Value An R2 value ≥ 0.99 indicates a close fit between the standard curve 
regression line and the individual CT data points of quantification 
standard reactions.

If the R2 value is <0.98 check the following:

• Quantity values entered for quantification standards in the Well 
Inspector during plate document setup.

• Making of serial dilutions of quantification standards.
• Loading of reactions for quantification standards.
• Failure of reactions containing quantification standards.
• CT value for Standard 8 of the DNA quantification standard 

(23 pg/µL) particularly for the male-specific standard curve.
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R2 Value < 0.98 If the R2 value is <0.98, you may choose to omit Std. 8 of the DNA 
quantification standard (23 pg/µL) from analysis. The Quantifiler® 
Duo DNA Quantification Kit assay can quantify 
23 pg/µL of human genomic DNA in a sample. When 2.0 µL of a 
sample at this concentration is loaded in a reaction, the well contains 
approximately 7 diploid human genome equivalents. These 
equivalents correspond to approximately 14 copies of the Duo 
Human target locus and approximately 7 copies of the Duo Male 
target locus (Y chromosome loci are haploid). Because of stochastic 
effects when using the lowest concentration point, the CT values are 
more variable and may affect the closeness of fit between the 
standard curve regression line and the individual data points of the 
quantification.

Slope A slope close to −3.3 indicates optimal, 100% PCR amplification 
efficiency.

The slope values listed in Table 5-1 represent the typical range of 
slope values observed during the development and validation of the 
Quantifiler® Duo kit. Some deviations from this range may be 
observed due to instrument performance. If the slope varies beyond 
the typical range indicated in Table 5-1, check the following:

• Assay setup
• Software setup
• Reagents
• Instrument

To omit Standard 8 from analysis:

1. Select the wells in the plate document that correspond to 
Standard 8 and open the Well Inspector.

2. Change the Task assignment for the applicable detector from 
Standard to Unknown.

3. Reanalyze the plate to incorporate the change.

Table 5-1 Range and average of standard-curve slope values

Kit Typical Slope (range) Average Slope

Quantifiler® Duo −3.0 to −3.6 −3.3
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Troubleshooting the Standard Curve
The following table and corresponding sections provide examples of 
errors that can result by applying incorrect detectors to standards 
during setup of the plate document. For instructions on how to apply 
detectors for standards correctly, see “Creating Detectors” on 
page 2-10. The standard curves shown in the following examples 
represent plots that result from incorrect detector setup and should 
not be used.

Table 5-2 Troubleshooting the standard curve

Observation Possible Cause Recommended Action

Slope for the standard curve is 
outside the typical range

or

R2 value is significantly less 
than 0.98 

The PCR reaction exhibits 
stochastic effects at the lowest 
concentration point.

Omit Standard 8 of the DNA 
quantification standard (23 
pg/µL) from analysis (see the 
procedure “To omit Standard 8 
from analysis:” on page 5-4).

When applying detectors for 
standards, the Task and 
Quantity were applied to the 
wrong detector (see “Example 
1” on page 5-6).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that the Task and 
Quantity were applied to the 
correct detector and 
reanalyze.

When applying detectors for 
the standards, the incorrect 
Quantity was entered (see 
“Example 2” on page 5-9).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that the correct 
Quantity was entered and 
reanalyze.
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The following examples illustrate the observations referenced in the 
table above.

Example 1 Observation

All of the CT values for the DNA quantification standard reactions 
for the Duo Human detector lie outside of the standard curve and 
form a horizontal line when All detectors are selected in the Standard 
Curve tab (Figure 5-1). Note that the affected detector disappears 
from the detector list and Duo IPC appears instead, as shown in the 
pull-down menu in Figure 5-2. As a result, the slope for the Duo 
Human standard curve was outside the typical range and the R2 value 
is significantly less than 0.98.

At each concentration only one 
standard curve is shown, either  
for the Duo Human or for the 
Duo Male detector

Only one detector was applied, 
either Duo Human or Duo Male, 
to each concentration of the 
standard curve (see “Example 
3” on page 5-10).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that both detectors 
Duo Human and Duo Male 
are applied, select the 
correct Task and Quantity 
and reanalyze.

At each concentration, the CT 
values for the Duo Human 
detector are higher than the CT 
values for the Duo Male 
detector

When creating detectors for the 
standards, FAM was selected 
as reporter dye for Duo Human 
and VIC was selected as 
reporter dye for Duo Male (see 
“Example 4” on page 5-11).

1. From the plate document, 
double-click a well 
containing a DNA 
quantification standard to 
view the Well Inspector.

2. Verify that at each 
concentration the correct 
reporter dye is selected for 
each detector, add new 
detectors, if necessary (see 
“Creating Detectors” on 
page 2-10), select the 
correct Task and Quantity, 
then reanalyze.

3. Do the same for the 
unknown sample wells.

Table 5-2 Troubleshooting the standard curve (continued)

Observation Possible Cause Recommended Action
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Figure 5-1 Example 1

Duo IPC 
selected as 
Standard 
instead of 
Duo Human

Duo Male

Legend: The Standard Task and Quantity were applied to the Duo IPC 
detector instead of the Duo Human detector, resulting in an incorrect 
representation of the Duo Human standard curve as a horizontal line.
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Figure 5-2 Example 1

Possible Cause

When applying detectors for the standards, the Task and Quantity 
were applied to the Duo IPC detector instead of to the Duo Human 
detector, as shown in Figure 5-3 below.

Figure 5-3 Example 1: Possible Cause

Duo IPC 
selected as 
Standard 
instead of 
Duo Human

Legend: The Standard Task and Quantity were applied to the Duo IPC 
detector instead of the Duo Human detector, resulting in an incorrect 
representation of the Duo Human standard curve AND only the Duo IPC 
Detector is displayed in the drop-down list.  Note the adjustment of the Y-
axis scale based on Detector selection.

Task and 
Quantity 
applied to 
wrong 
detector
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Example 2 Observation

One point for one detector (either Duo Human or Duo Male) lies 
outside of the standard curve. In Figure 5-4 below, Duo Human is the 
affected detector.

Figure 5-4 Example 2 

Possible Cause

When applying detectors for the standards, the incorrect Quantity 
was entered. As noted in Figure 5-5 below, 0.062 was entered for the 
Quantity instead of 0.62.

Outlier

Legend: One point lies outside the Duo Human standard curve.
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Figure 5-5 Example 2: Possible Cause

Example 3 Observation

At each concentration, only one standard curve is shown (either for 
the Duo Human or for the Duo Male detector) and only one detector 
(either Duo Human or Duo Male) is available in the Standard Curve 
tab. In Figure 5-6 below, Duo Human is the only detector available.

Figure 5-6 Example 3

Incorrect 
Quantity 
entered 
for 
standard

Legend: Only the Duo Human curve is available for display in the 
Standard Curve plot.
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Possible Cause

When applying detectors for the standards, Duo Male was not 
selected, as shown in Figure 5-7 below.

Figure 5-7 Example 3: Possible Cause

Example 4 Observation

At each concentration, the CT values for the Duo Human detector are 
higher than the CT values for the Duo Male detector. As shown in 
Figure 5-8 below, the whole standard curve for the Duo-Human 
detector lies on the right side of the Duo-Male standard curve when 
All Detectors are selected in the Standard Curve tab. The gap 
between the Duo Human and the Duo Male CT values may vary 
depending on the relative slopes of the two targets and instrument 
performance.

Task and 
Quantity 
not 
selected

Detector not applied
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Figure 5-8 Example 4: Observation

Possible Cause

When creating detectors for the standards as shown in Figure 5-9 
below, FAM was selected as the reporter dye for Duo Human and 
VIC was selected as the reporter dye for Duo Male instead of the 
opposite.

Figure 5-9 Example 4: Possible Cause

Duo Human

Duo Male

Legend: The Duo Human and Duo Male standard curves are exchanged.

Reporter dyes are flipped
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Using the Internal PCR Control System
Using the Internal PCR Control System

Purpose Use the Internal PCR Control (IPC) system to distinguish between 
true negative sample results and reactions affected by:

• The presence of PCR inhibitors
• Assay setup
• A chemistry or instrument failure

Components The following components of the IPC system are present in the 
Quantifiler® Duo Primer mix:

• Synthetic DNA template
• Primers that hybridize specifically to the synthetic DNA 

template
• Probe labeled with NED™ dye

Interpreting IPC
Results

In the amplification plot window of the SDS software, observe 
amplification of the VIC® and FAM™ dyes (Duo Human detector and 
Duo Male detector) and the NED™ dye (Duo IPC detector), then use 
Table 5-3 to interpret the IPC results.

Note: Positive amplification occurs when the CT value for the 
detector is <40. Because samples contain unknown amounts of DNA, 
a large range of CT values is possible. The IPC system template DNA 
is added to the reaction at a fixed concentration, therefore, the NED 
CT should range between 28 and 31, with a variation of 1 CT across 
the standard curve samples.

Table 5-3 Interpreting IPC amplification results

Duo Human (VIC® dye) and/or 
Duo Male (FAM™ Dye) Duo IPC (NED™ Dye) Interpretation

No amplification Amplification Negative result - no human 
DNA detected

No amplification No amplification Invalid result

Amplification
(low CT and high ΔRn)

No amplification or CT higher 
than 31

IPC result inconclusive

Amplification
(high CT and low ΔRn)

No amplification or CT higher 
than 31

PCR inhibition
Quantifiler® Duo DNA Quantification Kit User’s Manual 5-13



Chapter 5 Interpretation of Results
Negative Results No human DNA is detected when:

• No VIC® or FAM™ dye signal is detected, indicating that the 
human and/or male-specific targets did not amplify.

• NED™ dye signal (CT NED between 28 and 31) indicates that 
the IPC target was amplified; the PCR was not inhibited.

Invalid IPC
Results

If the human and/or male-specific targets and the IPC target failed to 
amplify, then it is not possible to distinguish between the absence of 
DNA, PCR reaction failure, and PCR inhibition.

IPC Results
Inconclusive

With extremely high concentrations of human genomic DNA 
(>10 ng/µL), competition between the human and/or male-specific 
and IPC PCR reactions may suppress IPC amplification for that 
sample. If the target amplifies with low CT and high ΔRn results, it is 
unlikely that PCR inhibitors are present. In these cases, appearance of 
suppression or failure of IPC amplification render the IPC result 
inconclusive.

PCR Inhibition Weak amplification (high CT value and low ΔRn value) of the human 
and/or male-specific targets and no or weak amplification of the IPC 
may indicate PCR inhibition (partial or complete) in the sample.

Determining the
Normal Range for

IPC

To determine the normal range of CT values for the IPC, view the 
NED™ dye signal in the amplification plots for the quantification 
standards. If the assays were set up correctly, the reactions should 
show normal IPC amplification across a broad range of input DNA; 
that is, a NED™ CT which falls between 28 and 31 with a variation of 
approximately 1 CT across the standard curve.

Evaluating PCR
Inhibition

If the IPC amplification for certain samples appears reduced relative 
to IPC amplification for quantification standards, the decreased IPC 
amplification may be interpreted as partial PCR inhibition. The IPC 
results can help you decide the next step:

• Proceed directly to an STR analysis of the sample
• Repeat the DNA extraction from the sample
• Perform additional cleanup of the sample to remove potential 

inhibitors
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Table 5-4 Troubleshooting amplification plots

Observation Possible Cause Recomme

ΔRn and CT values inconsistent with 
replicates

Evaporation of reaction mixture 
from some wells because the 
Optical Adhesive Cover was 
not sealed to the reaction plate 
properly or the compression 
pad was not used during the 
run.

1. Select the Compone
Affected wells should
less fluorescence co
replicates.

2. Check the amount o
the reaction plate.
Wells affected by eva
less solution than un
should correspond w
results.

For subsequent runs, m
Adhesive Cover is seale
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ΔRn and CT values inconsistent with 
replicates

Incorrect volume of 
Quantifiler® Duo PCR Reaction 
Mix added to some reactions.

1. Select the Compone
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different amounts of 
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2. Select the Spectra t
Wells with the incorre
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Jagged amplification plots

Weak lamp or incorrect 
replacement.

Replace the lamp or
replacement is corre

No defined amplification plots

Incorrect detector selected on 
the amplification plot or 
incorrect detector applied to 
the reactions when setting up 
the plate document. In the 
example, a detector that uses 
Cy5 as reporter dye was 
selected and applied in the 
amplification plot. 

1. Make sure that th
selected on the a

2. If the amplificatio
make sure setting
a. From the plate

well to view th
b. Verify that the 

and reanalyze
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nded Action
Abnormal ΔRn values or negative ΔRn 
values

Incorrect passive reference 
was selected when setting up 
the plate document. In the 
examples, Cy5, Cy3 or none 
was selected as passive 
reference, respectively.

1. From the plate docum
to view the Well Insp

2. Observe which Pass
selected.

Note: ROX should be 
Reference.

Table 5-4 Troubleshooting amplification plots (continued)
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Abnormally low ΔRn values, straight 
amplification plots, and low sensitivity 
across the whole plate.

Incorrect PCR Reaction Mix 
was used to set up the 
reactions (e.g. Quantifiler® 
Human or Y PCR Reaction Mix 
instead of Quantifiler® Duo 
PCR Reaction Mix). 

The first example shows the 
amplification plots of the 
standard curve wells when the 
Quantifiler® Human or Y PCR 
Reaction Mix is used. 

The second example shows 
the amplification plots of the 
standard curve wells with the 
expected ΔRn values when the 
Quantifiler® Duo PCR Reaction 
Mix is used.

From the plate docu
curve wells, click on
then change the ΔR
values look like the o
up the reactions aga
Reaction Mix.

Observation Possible Cause Recom



Assessing Quantity
Assessing Quantity

Purpose After viewing the results and assessing the quality of the results, the 
analyst can determine whether sufficient DNA is present to proceed 
with a short tandem repeat (STR) assay.

Assay Sensitivity The Quantifiler® Duo DNA Quantification Kit can quantify 
23 pg/µL of human genomic DNA in a sample. When 2.0 µL of a 
sample at this concentration is loaded in a reaction, the well contains 
approximately 7 diploid human genome equivalents. These 
equivalents correspond to approximately 14 copies of the Duo 
Human target locus and approximately 7 copies of the Duo Male 
target locus (Y chromosome loci are haploid).

Stochastic
Effects

In the 23-pg/µL concentration range, stochastic effects, or the 
statistical effect of sampling alleles present at a very low copy 
number, can produce significant variability in assay results. When 
using samples containing DNA in this concentration range, perform 
replicate analysis to confirm true absence of DNA.

Validity Detection and quantification of very low concentration (<100 pg) 
DNA samples is valid using the Quantifiler® Duo DNA 
Quantification Kit. However, the amount of DNA present in the 
sample may be below the working range of certain genotyping 
methods.

If Insufficient
DNA Is Present

If the results from Quantifiler® Duo DNA Quantification Kit 
reactions indicate that insufficient DNA is present to perform an STR 
assay, the analyst can:

• Re-extract the DNA, then repeat the test with the Quantifiler® 
Duo DNA Quantification Kit before performing STR analysis.

• Concentrate the sample, then repeat the test with the 
Quantifiler® Duo DNA Quantification Kit before performing 
STR analysis.
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Chapter 5 Interpretation of Results
Calculating Male : Female DNA Ratio
The Quantifiler® Duo Quantification Kit provides the quantity of 
human and male DNA in biological samples. From these values, one 
can calculate the ratio of male and female DNA using the following 
equation:

Male DNA : Female DNA Ratio = 
Male DNA/Male DNA : (Human DNA - Male DNA)/Male DNA

All quantities in the above equation are ng/µL.

For example, assuming:

Male DNA concentration = 2 ng/ul
Human DNA concentration = 8 ng/ul

then the Male DNA:Female DNA ratio is:

2/2 : (8-2)/2 = 1:3

This ratio determines the extent of the mixture and is useful in 
determining whether to proceed with autosomal STR or Y STR 
analysis.

Improving Assay Performance

Assessing Sensitivity and Results

About Assay
Sensitivity

Real-time PCR assays are extremely sensitive, and detection of CT 
values >35 may indicate the presence of exceedingly low quantities 
of DNA (<3 copies). Some user laboratories have reported the 
detection of CT values <40 for extraction blank and negative control 
samples while performing a real-time PCR reaction with the 
previously released Quantifiler® Kit assays.

Detection of such a low quantity of DNA can vary from amplification 
to amplification based on stochastic effects. Such levels may be 
considered background, and may not produce detectable product 
when the AmpFlSTR® Kits are used. The same observation applies 
to the Quantifiler® Duo DNA Quantification Kit.
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Improving Assay Performance
The Quantifiler® Duo DNA Quantification Kit reagents undergo 
rigorous quality control to ensure that the reagents are free of 
extraneous DNA. However, due to the extreme sensitivity of the test, 
background DNA from the environment can be detected on rare 
occasions. 

Each laboratory should take standard precautions to minimize 
contamination in its own facility. Each laboratory should also 
establish a CT value above which a positive result represents 
background DNA only. In this way, samples that are successfully 
amplified using the AmpFlSTR® Kits can be distinguished from 
those samples lacking sufficient target to generate an interpretable 
result.

Establishing the limits of the test is common practice in forensic 
laboratories when dealing with STR amplification results. Applied 
Biosystems recommends applying a similar approach when 
interpreting the results generated by the Quantifiler® Duo DNA 
Quantification Kit.

About False
Positive Results

When encountering false positive results (positive amplification of 
negative controls), note the following:

• The quantities obtained are usually well below the dynamic 
range of the standard curve. Therefore, these quantities 
may produce no STR or variable STR profiles.

• You can set a CT value threshold to proceed with STR 
analysis.

Note: Setting a CT value threshold requires further internal 
validation at your facility.

• It is important to distinguish between a real DNA signal 
due to the contamination of one reagent and a positive 
result due to spectral overlap between the various dyes.

Note: The 7500 SDS software uses a specialized 
multicomponenting algorithm that provides precise 
deconvolution of multiple dye signals in each well. This 
algorithm ensures minimal crosstalk when using multiple 
fluorophores for multiplex assays. However, a residual 
spectral overlap may be observed in the NTC wells, 
especially if the instrument is in need of calibration.
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Table 5-5 Troubleshooting false positives 

Observation Possible Cause Recom

CT values <40 are detected in NTC wells for 
the Duo Human and/or Duo Male detectors.

Spectral crosstalk into the 
FAM™ and/or VIC® channels.

1. From the plate do
wells, click on the
change the ΔRn s

2. If the ΔRn values 
reporter dye) and
reporter dye) dete
the curves cross 
threshold cycle a
instrument Pure D
the Applied Biosy
PCR System Inst
Guide for more d
procedures) and 

3. If the problem pe
Biosystems Tech

CT values <40 are detected in NTC wells for 
the Duo Human and/or Duo Male detectors.

Contamination of reagents due 
to DNA or amplified PCR 
products.

1. From the plate do
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change the ΔRn s
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Improving Assay Performance
Preventing PCR Contamination

Laboratory
Practices to

Minimize False
Positives

PCR assays require special laboratory practices to avoid false 
positive amplifications, as detailed in Table 5-5. The high sensitivity 
of these assays may result in the amplification of a single DNA 
molecule. 

To minimize false positives due to the presence of amplified material 
in your work area, follow these recommended laboratory practices:

• When possible, maintain separate work areas, dedicated 
equipment and supplies for:
– Sample preparation
– PCR setup
– PCR amplification
– Analysis of PCR products

• Wear a clean lab coat (not previously worn while handling 
amplified PCR products or during sample preparation) and 
clean gloves when preparing samples for PCR amplification.

• Change gloves whenever you suspect they are contaminated and 
before leaving the work area.

• Use positive-displacement pipettes or aerosol-resistant pipette 
tips.

• Never bring amplified PCR products into the PCR setup area.
• Open and close all sample tubes and reaction plates carefully.
• Try not to splash or spray PCR samples.
• When pipetting from a kit component tube, hold the cap of the 

tube in your gloved hand, or be sure to set it down on a clean, 
decontaminated surface.

• Keep reactions and components sealed when possible.
• Do not open sealed reaction tubes or plates after amplification.
• Clean lab benches and equipment periodically with freshly 

diluted 10% bleach solution.
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Chapter 6 Experiments and Results
Overview

About This
Chapter

This chapter provides results of the validation experiments performed 
by Applied Biosystems using the Quantifiler® Duo DNA 
Quantification Kit.

Importance of
Validation

Although the Quantifiler® Duo DNA Quantification kit is not a DNA 
genotyping assay, it is intended for use before performing genotyping 
assays such as the AmpFlSTR® PCR Amplification Kits. By testing 
the procedure with samples commonly encountered in forensic and 
parentage laboratories, the validation process establishes attributes 
and limitations that are critical for sound data interpretation.

Experiments Experiments to evaluate the performance of the Quantifiler® Duo 
DNA Quantification Kit were performed at Applied Biosystems 
according to the Revised Validation Guidelines issued by the 
Scientific Working Group on DNA Analysis Methods (SWGDAM) 
published in Forensic Science Communications Vol. 6, No. 3, July 
2004: 

(http://www.fbi.gov/hq/lab/fsc/backissu/july2004/standards/2004_03
_standards02.htm#perfcheck). 

These guidelines describe the quality assurance requirements that a 
laboratory should follow to ensure the quality and integrity of the 
data and competency of the laboratory. 

The experiments focus on kit performance parameters relevant to the 
intended use of the kits as human-specific DNA quantification assays 
and as a part of a forensic DNA genotyping procedure. Each 
laboratory using the Quantifiler® Duo DNA Quantification Kit 
should perform appropriate internal validation studies.
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Developmental Validation
Developmental Validation
The validation studies are described with reference to the standard 
numbers noted in the Scientific Working Group on DNA Analysis 
Methods (SWGDAM) Guidelines. The stock DNA samples used for 
the validation study were quantified using the validation lot of the 
Quantifiler® Duo kit to establish baseline DNA concentrations from 
which the dilutions were made.

Mapping
(Std. 2.1.2)

The chromosomal location of the genetic markers that are used as  
target regions for quantification of human and male DNA are 
described in this section.

Human DNA

The quantification of human DNA using the Quantifiler® Duo DNA 
Quantification Kit is based on the amplification of a region from the 
ribonuclease P RNA component H1 (RPPH1) gene: 

• Official Symbol: RPPH1
• Name: ribonuclease P RNA component H1 [Homo sapiens] 
• Other Aliases: H1 RNA, H1RNA 
• Chromosome: 14; Location: 14q11.2 
• GeneID: 85495

Insert the GeneID number into the “Search For” box on the following 
linked page: 

• http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?CMD=search&D
B=gene

Male DNA

The quantification of human male DNA using the Quantifiler® Duo 
DNA Quantification Kit is based on the amplification of a region 
from the sex determining region Y (SRY) gene: 

• Official Symbol: SRY
• Name: sex determining region Y [Homo sapiens] 
• Other Aliases: TDF, TDY 
• Other Designations: essential protein for sex determination in 

human males; sex determining region protein; sex-determining 
region on Y; testis-determining factor 
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Chapter 6 Experiments and Results
• Chromosome: Y; Location: Yp11.3 
• GeneID: 6736 
• The assay maps upstream of the reference sequence mRNA 

gi|4507224|ref|NM_003140.1|

Insert the GeneID number into the “Search For” box on the following 
linked page: 

• http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?CMD=search&D
B=gene

Detection
(Std. 2.1.3)

Quantification of the human and human male DNA, and qualitative 
indication of the presence of PCR inhibitors in a biological sample 
are determined by the measurement of fluorescent dye released 
during the amplification process. The fluorescent dyes are linked to 
sequence specific nucleotide probes. The principle of detection and 
details of the assay are described in Chapter 1, “Chemistry 
Overview” on page 1-3 in this document.

Species
Specificity

(Std. 2.2)

The Quantifiler® Duo DNA Quantification Kit measures the quantity 
of human and human male DNA in forensic-type samples. The 
quantification results are further used to determine the optimal 
amount of DNA sample to be used for genotyping assays. Since the 
forensic-type samples are often contaminated with non-human DNA, 
specificity measurements of primers and probes in the Quantifiler® 
Duo DNA Quantification Kit are crucial. Specificity is confirmed 
through experimentation.

Experiment

Cross reactivity of primers and probes in the Quantifiler® Duo DNA 
Quantification Kit was examined by testing DNA from various non-
human species. Human DNA samples were used as controls (see 
Table 6-1 for details). The DNA from non-human biological species 
was either obtained commercially or purified in the laboratory. For 
some of these DNA samples, the sex of the donor animal was 
unknown. For some species, multiple donor animals were tested 
(annotated as A and B).

Most of the reactions utilized 5.0 ng of input DNA. For a few 
reactions, 10 ng of input DNA was used. For the two human samples, 
5.0 ng of DNA was used in the amplification reactions. 
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Results

The two human control samples that were tested produced the 
expected results as shown in Table 6-1.

Table 6-1 Specificity with a non-human DNA panel

Organism Sex RPPH1
Average CT

SRY
Average CT

Orangutan Unknown 40 40

Chimpanzee A Unknown 40 32.3

Chimpanzee B Unknown 40 31.1

Gorilla A Unknown 40 40

Gorilla B Unknown 40 40

Macaque Unknown 40 40

Dog Unknown 40 40

Cow Unknown 40 40

Pig Unknown 40 40

Cat Unknown 40 40

Horse Unknown 40 40

Sheep Unknown 40 40

Chicken Unknown 40 40

Fish Unknown 40 40

Rabbit Unknown 40 40

Mouse Unknown 40 40

Rat Unknown 40 40

Hamster Unknown 40 40

Human Male Male 27 27.9

Human Female Female 27.5 40

Dog Male 40 40

Bovine Male 40 40

Pig Male 40 40

Horse Male 40 40

Sheep Male 40 40

Chicken Male 40 40
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Chapter 6 Experiments and Results
The Quantifiler® Duo DNA Quantification Kit:

• Detected DNA from a human male individual with a CT value of 
27 (RPPH1) and 27.9 (SRY).

• Detected DNA from a human female individual with a CT value 
of 27.5 (RPPH1). 

• Detected DNA from two chimpanzees with relatively lower 
efficiency, producing CT values of 32.3 and 31.1 for the SRY 
assay only.

• Did not detect DNA from the remaining non-human species.

Thus, the Quantifiler® Duo DNA Quantification Kit detected DNA 
from only one non-human species at a significantly reduced 
efficiency. This degree of cross-reactivity of primers and probes for 
higher primates is well documented.

Sensitivity
Studies (Std. 2.3)

Sensitivity studies were performed to determine the range of DNA 
concentrations that can be reliably quantified and detected using the 
Quantifiler® Duo assay.

Rabbit Male 40 40

Mouse Male 40 40

Rat Male 40 40

Escherichia coli NA 40 40

Pseudomonas aeruginosa NA 40 40

Neisseria gonorrheae NA 40 40

Staphylococcus aureus NA 40 40

Saccharomyces cerevisiae NA 40 40

Candida albicans NA 40 40

Table 6-1 Specificity with a non-human DNA panel (continued)
6-6 Quantifiler® Duo DNA Quantification Kit User’s Manual



Developmental Validation
Experiment

Two human male DNA samples obtained from commercial sources 
(Table 6-2) were each diluted to obtain concentrations of 20.0, 5.0, 
1.0, 0.1, 0.05, 0.04, 0.03, 0.023, 0.0115, 0.00575, 0.002875 and 
0.00144 ng/µL inT10E0.1 buffer. Each dilution was quantified in 
triplicate using the Quantifiler® Duo DNA Quantification Kit. For 
each 25-µL reaction, 2.0 µL of DNA sample was used.

Results 

The quantities of DNA obtained from the Quantifiler® Duo DNA 
Quantification Kit were very similar to the expected quantities across 
a range of concentrations from 20 ng/µL to 23 pg/µL (as shown in 
Table 6-3). Furthermore, quantities as low as 11.5 pg/µL of human 
DNA were reproducibly detected across all replicates using the 
Quantifiler® Duo DNA Quantification Kit (as shown in Table 6-3). 

At concentrations of 5.75 pg/µL and below, human DNA cannot be 
reproducibly detected across all replicates due to stochastic variation 
in the amplification efficiency resulting from low DNA input 
amounts (Table 6-3). Stochastic effects provide greater variation in 
the quantification results from samples containing lower quantities of 
DNA. In general, for samples containing DNA at concentrations of 
0.1 ng/µL or less, it is necessary to add the maximum volume of 
DNA extract to the AmpFlSTR® kit STR reaction. 

A plot of the CT values versus the known DNA quantities (see 
Figure 6-1 and Figure 6-2) showed the expected log-linear 
relationship between the two quantities from 20 ng/µL to 23 pg/µL. 
For each dilution series, the data points formed an acceptable 
standard curve. 

Table 6-2 Human DNA samples tested for sensitivity

Sample Source

1 Human male blood (pool)

2 Human male blood (single source)
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Table 6-3 Sensitivity using the Quantifiler® Duo DNA 
Quantification Kit

Sample 
Expected 
Quantity 

ng/µL

Measured 
Quantity 
(RPPH1)

ng/µL

Measured 
Quantity 

(SRY)
ng/µL

1 20 18.500 19.540

1 5 4.000 4.330

1 1 0.832 0.909

1 0.1 0.099 0.111

1 0.05 0.050 0.048

1 0.04 0.039 0.053

1 0.03 0.026 0.033

1 0.023 0.020 0.022

1 0.01150 0.014 0.009

1 0.00575 0.010 0.007

1 0.00288   ----  0.000

1 0.00144   ----  0.006

2 20 20.910 20.383

2 5 4.943 4.800

2 1 0.802 0.751

2 0.1 0.096 0.108

2 0.05 0.056 0.058

2 0.04 0.038 0.039

2 0.03 0.038 0.031

2 0.023 0.022 0.033

2 0.01150 0.015 0.016

2 0.00575 0.010   ----  

2 0.00288 0.006 0.007

2 0.00144   ----    ----  
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Figure 6-1 Sensitivity for the male target using the Quantifiler® 
Duo DNA Quantification Kit
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Figure 6-2 Sensitivity for the human target using the Quantifiler® 
Duo DNA Quantification Kit

Stability Studies:
Inhibited Sample
Studies (Std. 2.4)

The stability studies were conducted to demonstrate the performance 
of the Quantifiler® Duo kit when used to quantify samples subjected 
to environmental and chemical insults, such as those samples 
containing PCR inhibitors and degraded DNA. Forensic DNA 
extracts commonly contain compounds that inhibit the amplification 
of nucleic acids.These PCR inhibitors can interfere with the reaction 
and cause varying levels of reduced PCR efficiency, including 
complete inhibition of PCR. 

A wide variety of compounds that may inhibit PCR have been 
reported. One example is hematin, which has been found in DNA 
samples extracted from blood stains. Because the solubility of 
hematin is similar to that of DNA, it is thought that hematin is co-
extracted and purified with the DNA. The presence of hematin in 
DNA samples may interfere with PCR by inhibiting DNA 
polymerase activity. Humic acid is yet another example of a PCR 
inhibitor that has been found in forensic-type samples contaminated 
with soil.
6-10 Quantifiler® Duo DNA Quantification Kit User’s Manual



Developmental Validation
Experiment 1

Human genomic DNA was mixed with varying concentrations of 
hematin and humic acid to assess the impact of inhibitors on both the 
Quantifiler Duo reactions and the subsequent STR reactions 
performed using the AmpFlSTR Identifiler Kit. Hematin 
concentrations of 0, 2.5, 5.0, 7.5, 10, 12.5, 15, 17.5, 20, and 40 µM 
and humic acid concentrations of 0, 1.0, 2.0, 3.0, 3.75, 7.5, 11.25, 15, 
and 30 ng/µLwere evaluated. The concentrations described here are 
final concentrations of respective inhibitor in 25 µL PCR when 2 µL 
of sample is added. 2 µL of each sample, containing approximately 
1.0 ng of DNA, was quantified in triplicate using the Quantifiler® 
Duo DNA Quantification Kit. The same amount of each replicate 
sample was subsequently added to AmpFlSTR® Identifiler® PCR 
Amplification Kit reactions in order to have the same final 
concentration of inhibitor in both the quantification and the STR 
reaction. The STR reactions were analyzed on an Applied 
Biosystems 3130xl Genetic Analyzer instrument. Data were analyzed 
using GeneMapper® ID Software v3.2.1. 

Results 1

The histograms (Figure 6-3 and Figure 6-4) illustrate higher CT 
values as the concentrations of hematin and humic acid increased. 
CT values were relatively stable up to 7.5 µM hematin and 3.0 ng/µL 
humic acid, with results displaying more pronounced CT shifts at 
higher concentrations. As the concentrations of hematin and humic 
acid increased, the PCR efficiency in the Quantifiler® Duo DNA 
Quantification Kit decreased. Complete inhibition of the 
amplification occurred at 15.0 µM hematin and 11.25 ng/µL humic 
acid. 

In general, the CT values for all targets (human, human male and 
IPC) were affected similarly using comparable concentrations of 
inhibitors (see Figure 6-3 and Figure 6-4).
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Figure 6-3 CT values for hematin-inhibited samples using the 
Quantifiler® Duo DNA Quantification Kit

Figure 6-4 CT values for humic acid-inhibited samples using the 
Quantifiler® Duo DNA Quantification Kit
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STR analysis was performed using the Identifiler® Kit. The volume 
of extract used for STR amplification was equal to the volume used 
for quantification (2 µL).  The Identifiler® Kit results (Figure 6-6 and 
Figure 6-8) were consistent with the results from the Quantifiler® 
Duo DNA Quantification Kit (Figure 6-5 and Figure 6-7): As the 
concentrations of hematin and humic acid increased (indicated by the 
increasing IPC CT values), the overall STR peak heights decreased. 
Complete STR profiles were obtained at 10 µM hematin and 3.75 
ng/µL humic acid. The STR amplification reaction was completely 
inhibited at 40 µM hematin and 30 ng/µL humic acid. Thus, the 
results from the Quantifiler® Duo DNA Quantification Kit provided 
reasonable predictions of samples that would produce lower quality 
STR profiles due to the presence of a PCR inhibitor.

Figure 6-5 IPC CT values obtained for samples containing a 
range of hematin concentrations
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Figure 6-6 Identifiler® Kit profiles obtained for samples 
containing a range of hematin concentrations
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Figure 6-7 IPC CT values obtained for samples containing a 
range of humic acid concentrations
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Figure 6-8 Identifiler® Kit profiles obtained for samples 
containing a range of humic acid concentrations
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Experiment 2

In this experiment the same samples described in Experiment 1 
(Human genomic DNA mixed with varying concentrations of 
hematin and humic acid) were analyzed. However, in this experiment 
2 µL of each sample, containing approximately 1.0 ng of DNA, was 
quantified in triplicate using the Quantifiler® Duo DNA 
Quantification Kit, and the quantification results from the RPPH1 
human target were used to determine the sample volume necessary 
for the autosomal STR reaction. In this way, the impact of the 
inhibitor concentration on the quantification results was evaluated. 
Further, the effect of the altered quantification results on the quality 
of the STR profile was studied for both the AmpFlSTR® Identifiler® 
Kit and the AmpFlSTR® MiniFiler™ Kit. 

1.0 ng of template DNA was used in the PCR amplification reaction 
using the AmpFlSTR® Identifiler® Kit. For the AmpFlSTR® 
MiniFiler™ PCR Amplification Kit reactions, varying quantities of 
input DNA including 0.1, 0.25 and 0.5 ng were used. The 
electropherograms displayed in Figure 6-12 and Figure 6-14 
represent the optimal input DNA amounts at the corresponding 
inhibitor level. For simplicity, in the STR panels (Figure 6-9 through 
Figure 6-14) we refer to the inhibited samples using the inhibitor 
concentration indicated in Table 6-4 in the Sample Name column 
(final concentration in the quantification reaction, or 2 µL in a 25 µL 
reaction volume). However, the actual final inhibitor concentration in 
the STR reactions will vary and is determined by the volume of 
sample used for amplification.

Results 2

The presence of hematin and humic acid adversely affected the 
quantification of DNA in a sample due to the inhibition of PCR. The 
quantification results obtained from each sample are summarized in 
Table 6-4 and indicate that the quantity of DNA was underestimated 
when the concentrations of hematin and humic acid were increased. 
Hematin and humic acid at concentrations higher than 12.5 µM and 
7.5 ng/µL, respectively, completely inhibited the PCR, and no DNA 
was detectable in these samples.
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Table 6-4 Quantification of inhibited samples using the Quantifiler® Duo DNA 
Quantification Kit

Sample 
Name

Inhibitor 
Name

Quantity 
(SRY) 
ng/µL

StdDev 
(SRY)

Quantity 
(RPPH1) 

ng/µL

StdDev 
(RPPH1)

CT value 
(IPC)

StdDev 
(IPC)

0 µM Hematin 0.411 0.033 0.397 0.045 29.647 0.112

2.5 µM Hematin 0.406 0.099 0.399 0.029 29.833 0.078

5 µM Hematin 0.393 0.041 0.358 0.045 29.677 0.123

7.5 µM Hematin 0.371 0.035 0.253 0.030 30.050 0.122

10 µM Hematin 0.092 0.013 0.024 0.010 31.753 0.377

12.5µM Hematin 0.007 0.004 0.000  --- 35.347 1.048

15 µM Hematin 0.000 0.000 0.000  --- 40.000  ---

17.5 µM Hematin 0.000 0.000 0.000  --- 40.000  ---

20 µM Hematin 0.000 0.000 0.000  --- 40.000  ---

40 µM Hematin 0.000 0.000 0.000  --- 40.000  ---

0 ng/µL Humic acid 0.411 0.033 0.397 0.045 29.647 0.112

  1 ng/µL Humic acid 0.381 0.077 0.359 0.034 29.783 0.054

  2 ng/µL Humic acid 0.370 0.060 0.244 0.029 29.813 0.071

  3 ng/µL Humic acid 0.275 0.058 0.105 0.023 30.263 0.142

  3.75 ng/µL Humic acid 0.155 0.041 0.055 0.016 30.807 0.411

  7.5 ng/µL Humic acid 0.006 0.005 0.000  --- 35.207 1.540

  11.25 ng/µL Humic acid 0.000 0.000 0.000  --- 40.000  ---

  15 ng/µL Humic acid 0.000 0.000 0.000  --- 40.000  ---

  30 ng/µL Humic acid 0.000 0.000 0.000  --- 40.000  ---
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The results of the STR analysis with the Identifiler® kit, using 1.0 ng 
of template DNA for PCR amplification, are presented in Figure 6-9 
and Figure 6-10. The volume of the extract used for amplification 
was based on the quantification results (RPPH1 target) summarized 
in Table 6-4. 

A full and interpretable profile was obtained for samples labeled as 
0 µM, 2.5 µM, and 5 µM hematin as well as 0 ng/µL, 1 ng/µL, and 
2 ng/µL humic acid. Samples labeled as 7.5 µM hematin and 3 ng/µL 
humic acid exhibited partial profiles. All other samples did not 
provide any STR profile. As previously described, these 
concentrations correspond to the final inhibitor concentration in the 
quantification reaction (2 µL in a 25-µL reaction volume) and not to 
the actual final inhibitor concentration in the STR reaction. The 
results indicate that an upward shift in the IPC CT value with the 
Quantifiler® Duo DNA Quantification Kit can be used to signal that 
STR analysis may result in a partial profile or in the inability to 
obtain an STR profile.
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Figure 6-9 Identifiler® Kit profiles obtained for samples 
containing a range of hematin concentrations. Label corresponds 
to inhibitor concentration in the Quantifiler® Duo reaction.
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Figure 6-10 Identifiler® Kit profiles obtained for samples 
containing a range of humic acid concentrations. Label 
corresponds to inhibitor concentration in the Quantifiler® Duo 
reaction.
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The MiniFiler™ kit is designed to obtain STR profiles from 
compromised samples such as those which may be inhibited and/or 
degraded. The results of the STR analysis using the MiniFiler™ Kit, 
with varying DNA input amounts, are presented in Figure 6-11, 
Figure 6-12, Figure 6-13, and Figure 6-14. 

Control samples that did not contain any inhibitor provided complete 
profiles when using 0.25 ng of template DNA for amplification. 
Inhibited samples labeled as 2.5 µM, 5.0 µM, 7.5 µM hematin and 
1 ng/µL and 2 ng/µL humic acid provided complete profiles when 
using 0.1 ng of DNA template, as quantified by the Quantifiler® Duo 
DNA Quantification Kit. 

Using 10 µL of all the other samples (because of low or no 
quantification results) resulted in either partial or uninterpretable 
results (see Figure 6-11, panels E-J and Figure 6-13, panels F-I). 
These results are consistent with observations of an IPC CT shift 
during quantification using the Quantifiler® Duo kit. 

Every PCR system; e.g., Quantifiler® Duo, Identifiler®, and 
MiniFiler™ Kits, has a unique reagent formulation that provides a 
varying response to samples containing inhibitors. When samples 
labeled as 10 µM, 12.5 µM, 15 µM, 17.5 µM, 20 µM, 40 µM hematin 
and  3 ng/µL, 3.75 µL, 7.5 ng/µL, 11.25 ng/µL, 15 ng/µL, 30 ng/µL 
humic acid were diluted (at 1:20 or 1:50), conclusive interpretable 
profiles were provided when amplified using the MiniFiler™ Kit 
(Figure 6-12 and Figure 6-14). As previously described, these 
concentrations correspond to the final inhibitor concentration in the 
quantification reaction and not to the actual final concentration in the 
STR reaction.
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Figure 6-11 MiniFiler™ Kit analysis of hematin-inhibited samples 
before dilution of highly inhibited samples
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20 µM, 10 µL
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Note: 0.25 ng of human DNA is used for amplification of the sample in panel A. 
0.1 ng of human DNA is used for amplification of samples in panels B, C, and D. 
10 µL of the extract is used for amplification of samples in panels E through J. 
Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
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Figure 6-12 MiniFiler™ Kit analysis of hematin-inhibited samples 
after dilution of highly inhibited samples
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Note: 0.25 ng of human DNA is used for amplification of the sample in panel A. 
0.1 ng of human DNA is used for amplification of samples in panels B, C, and D. 
10 µL of the diluted extract as indicated is used for amplification of samples in 
panels E through J. Label corresponds to inhibitor concentration in the Quantifiler® 
Duo reaction.
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Figure 6-13 MiniFiler™ Kit analysis of humic acid-inhibited 
samples before dilution of highly inhibited samples

A

B

C

D

E

F

G

H

I

0 ng/µL 0.25 ng

1 ng/µL, 0.1 ng
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Note: 0.25 ng of human DNA is used for amplification of the sample in panel A. 
0.1 ng of human DNA is used for amplification of samples in panels B and C. 
0.05 ng of human DNA is used for amplification of the sample in panel D. 
0.03 ng of human DNA is used for amplification of the sample in panel E. 
10 µL of the extract is used for amplification of the samples in panels F, G, H and I. 
Label corresponds to inhibitor concentration in the Quantifiler® Duo reaction.
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Figure 6-14 MiniFiler™ Kit analysis of humic acid-inhibited 
samples after dilution of highly inhibited samples
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Note: 0.25 ng of human DNA is used for amplification of the sample in panel A. 
0.1 ng of human DNA is used for amplification of samples in panels B and C. 
10 µL of the diluted extract as indicated is used for amplification of samples in 
panels D through I. Label corresponds to inhibitor concentration in the Quantifiler® 
Duo reaction.
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Stability Studies:
Degraded DNA

Studies (Std. 2.4)

Forensic samples may be exposed to environmental conditions that 
degrade DNA molecules and reduce amplification efficiency in PCR 
reactions. Exposure to environmental conditions may cause 
fragmentation of full length DNA molecules and can reduce the 
overall concentration of amplifiable DNA. Because of such potential 
occurrences, the validation of forensic DNA methods involves 
studies of the effects of degradation on the amplification and 
detection of DNA. 

Degraded DNA samples were tested with the Quantifiler® Duo DNA 
Quantification Kit to determine the quantity of amplifiable DNA at 
increasing levels of degradation. Results obtained using the RPPH1 
human target of the Quantifiler® Duo DNA Quantification Kit were 
used to calculate DNA input for subsequent STR analysis.

Experiment

A sample of high-molecular weight human-genomic DNA was used 
to generate a series of samples with varying levels of degradation. 
1µg of DNA (100 µL reaction at 10 ng/µL concentration) was treated 
for 20 minutes using increasing quantities of the DNase I enzyme; 
0.002, 0.01, 0.02, 0.05, 0.1 and 0.2 units. Samples were run on a 4% 
agarose gel for 25 minutes and visualized by staining with ethidium 
bromide to estimate the extent of degradation. The degraded DNA 
samples were quantified with the Quantifiler® Duo DNA 
Quantification Kit.

Results

Agarose gel electrophoresis showed that DNase I treatment produced 
DNA fragments with sizes of 100 basepairs (bp) or less, when 0.1 
unit of DNase was used (Figure 6-15).
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Figure 6-15 DNase I degradation of human genomic DNA

Lower amounts of amplifiable DNA were detected using the 
Quantifiler® Duo DNA Quantification Kit for those samples treated 
with higher amounts of DNase I. According to results from the 
Quantifiler® Duo DNA Quantification Kit (RPPH1 target), the 
amount of amplifiable DNA decreased from about 7.69 ng/µL to 
3.43 ng/ µL when 0.02 units of DNase I was used, and to 0.03 ng/µL 
when 0.2 units of DNase I was used. Similar values were obtained 
from the SRY target assay.
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Legend: Lane 1: 0 units of DNAse I; Lane 2: 0.002 units 
of DNAse I; Lane 3: 0.01 units of DNAse I; Lane 4: 0.02 
units of DNAse I; Lane 5: 0.05 units of DNase I; Lane 6: 
0.1 units of DNase I; Lane 7: 0.2 units of DNase I; Lane 
8: Size standards. 

-150 bp
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Figure 6-16 Degraded DNA: Quantifiler® Duo RPPH1 
amplification plot 

Table 6-5 Quantifiler® Duo DNA Quantification Kit results

Sample 
Name 

DNase I 
Units

Quantity 
(SRY) 
ng/µL

StdDev 
(SRY)

Quantity 
(RPPH1) 

ng/µL

StdDev 
(RPPH1)

CT value 
(IPC)

StdDev 
(IPC)

1 0 7.07 0.08 7.69 0.64 29.61 0.24

2 0.002 5.92 0.20 6.51 0.39 29.60 0.13

3 0.01 4.77 0.06 5.11 0.13 29.67 0.11

4 0.02 3.23 0.10 3.43 0.33 29.75 0.08

5 0.05 0.50 0.04 0.57 0.13 29.77 0.07

6 0.1 0.10 0.01 0.08 0.01 29.90 0.11

7 0.2 0.02 0.01 0.03 0.01 29.83 0.05

Increasing degradation

Samples 1 and 2

Sample 3

Sample 4

Sample 5

Sample 6

Sample 7
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Figure 6-17 Degraded DNA: Quantifiler® Duo SRY amplification 
plot 

1.0 ng of each sample in the degraded DNA series was added to 
Identifiler® Kit reactions based on DNA quantification results 
obtained using the Quantifiler® Duo DNA Quantification Kit 
(RPPH1 human target). As the extent of degradation increased, the 
concentration of amplifiable DNA decreased, resulting in the need to 
add a higher volume of sample to the subsequent PCR reaction. 
10 µL of sample was added to the Identifiler® Kit reactions for those 
samples containing 0.1 ng/µL DNA or less. The peak heights (rfu 
values) of the alleles for STR loci with longer amplicons decreased 
for those degraded samples generated with 0.01 and higher units of 
DNase I (samples 3 to 7). However, complete interpretable STR 
profiles were obtained for samples generated with up to 0.02 units of 
DNase I (samples 1 to 4). Partial STR profiles were obtained for 
those samples generated with 0.05 and higher units of DNase I 
(samples 5 to 7) (Figure 6-18). 
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Figure 6-18 STR analysis of samples from the degraded DNA 
series using the Identifiler® Kit. 

Based on the DNA quantification results from the RPPH1 human 
target of the Quantifiler® Duo DNA Quantification Kit, 0.25 ng of 
each DNA sample was added to MiniFiler™ Kit reactions. The data 
is presented in Figure 6-19. Conclusive and complete STR profiles 
were obtained for samples that were generated using up to 0.02 units 
of DNase I (samples 1 to 4). The samples that were generated using 
up to 0.05 and 0.1 units of DNase I (samples 5 and 6) provided 
interpretable profiles; however, the amplitude (rfus) of the alleles for 
STR loci with longer amplicons decreased. Samples that were 
generated using 0.2 units of DNase I (sample 7) when amplified 
using 0.1 ng of template DNA provided interpretable profiles with 
low amplitude (rfus) for all loci. 

The results indicate that interpretable profiles can be recovered from 
all the degraded samples generated in this study when using the 
Minifiler™ Kit.
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Legend: The sample numbers to the left of the figure refer to the sample numbers in Table 6-5.
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The MiniFiler™ Kit is specifically designed to obtain STR profiles 
from compromised samples. The size range of the amplicons 
generated using the MiniFiler™ Kit is relatively smaller (70 to 283 
bases) than those generated using the Identifiler® Kit (102 to 359 
bases) and therefore the success rate is higher, as demonstrated by the 
results.

Figure 6-19 STR analysis of samples from the degraded DNA 
Series using the MiniFiler™ Kit

In general, these results demonstrate that the Quantifiler® Duo DNA 
Quantification Kit can be used to assess the amount of amplifiable 
DNA in a degraded sample. At extreme levels of degradation, it may 
not be possible to obtain results from the Quantifiler® Duo DNA 
Quantification Kit or the STR kits.
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Legend: The sample numbers to the left of the figure refer to the sample numbers in Table 6-5.
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Reproducibility
Study (Std 2.5)

Replicate analysis of human DNA samples was performed using the 
Quantifiler® Duo Kit to assess the reproducibility of the 
quantification results obtained.

Experiment

Four male and one female genomic DNA samples were tested to 
assess the reproducibility of the quantification results (Table 6-6). 
The DNA samples were diluted from initial estimated concentrations 
to 20.0, 10.0, 1.0, 0.1 and 0.05 ng/µL. All dilutions were made in 
T10E0.1 Buffer. All samples and dilutions were tested in triplicate 
using the Quantifiler® Duo DNA Quantification Kit. Three different 
runs were performed. For each sample reaction the CT values were 
obtained and the DNA quantities calculated. The mean quantity and 
standard deviation were calculated for each sample dilution. The 95% 
confidence interval values were calculated as the mean of the DNA 
quantity, ± 2 standard deviation units for each sample, and expressed 
as a percentage of the mean quantification result.

Results

The following table shows the DNA quantity calculated for all 
samples and dilutions tested for all three runs using the Quantifiler® 
Duo DNA Quantification Kit (Table 6-7).

Table 6-6 Human DNA samples tested for reproducibility

Sample Name Source Sex

A Human blood (single source) Male

B Human blood (single source) Male

C Human blood (pool) Male

D Human blood (single source) Male

E Human blood (single source) Female
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6-34 Table 6-7 Reproducibility using the Quantifiler® Duo Kit

 CT
Std Dev 
IPC CT

 95% 
Conf. 
IPC 

(± %)

70 0.037 0.25
73 0.034 0.23
92 0.034 0.23
97 0.039 0.26
00 0.032 0.21

79 0.038 0.25
77 0.046 0.31
89 0.030 0.20
98 0.040 0.27
98 0.012 0.08

62 0.055 0.37
67 0.053 0.36
81 0.057 0.38
89 0.053 0.36
81 0.047 0.32

90 0.106 0.71
87 0.028 0.19
76 0.055 0.37
02 0.034 0.22
97 0.042 0.28

97 0.023 0.16
87 0.007 0.04
77 0.018 0.12
73 0.089 0.60
71 0.047 0.32
Q
uantifiler ® D

uo D
N

A
 Q

uantification K
it U

ser’s M
anual

Sample
Sample 
Dilution 
(ng/µL)

Mean 
Qty SRY 
(ng/µL)

Std Dev 
SRY 

 95% 
Conf.
SRY 
(± %)

Mean 
Qty 

RPPH1 
(ng/µL)

Std Dev 
RPPH1

95% 
Conf. 

RPPH1 
(± %)

IPC

A 20 20.10 1.051 10.46 21.15 0.804 7.60 29.
A 10 8.98 0.400 13.36 9.11 0.341 11.49 29.
A 1 0.85 0.109 17.84 0.87 0.051 8.67 29.
A 0.10 0.08 0.007 25.83 0.09 0.015 17.86 29.
A 0.05 0.05 0.028 34.00 0.04 0.002 63.43 30.

B 20 23.09 2.219 19.23 24.36 1.656 13.59 29.
B 10 11.22 0.485 1.45 11.49 0.529 15.11 29.
B 1 1.15 0.142 20.76 1.14 0.083 29.23 29.
B 0.10 0.11 0.013 42.93 0.10 0.008 42.32 29.
B 0.05 0.05 0.015 16.92 0.06 0.007 43.10 29.

C 20 23.11 0.821 7.10 22.51 0.294 2.61 29.
C 10 9.25 0.601 35.03 8.72 0.562 32.37 29.
C 1 0.89 0.039 10.40 0.82 0.027 5.40 29.
C 0.10 0.11 0.027 10.00 0.10 0.008 23.96 29.
C 0.05 0.04 0.020 68.07 0.04 0.008 90.52 29.

D 20 26.49 2.116 15.98 27.28 1.835 13.45 29.
D 10 13.09 0.596 12.20 13.26 0.261 9.44 29.
D 1 1.26 0.136 8.54 1.22 0.081 16.18 29.
D 0.10 0.12 0.032 43.59 0.12 0.008 28.35 30.
D 0.05 0.07 0.021 14.12 0.06 0.006 22.12 29.

E 20 female  ----  ---- 24.91 0.586 4.70 29.
E 10 female  ----  ---- 12.11 0.486 8.94 29.
E 1 female  ----  ---- 1.14 0.049 6.55 29.
E 0.10 female  ----  ---- 0.12 0.016 21.07 29.
E 0.05 female  ----  ---- 0.06 0.008 67.71 29.
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The 95% confidence interval shows the approximate range expected 
for results when using the Quantifiler® Duo DNA Quantification Kit. 
The average 95% confidence interval is  ± 24.2 % and  ± 21.4% for 
the human and the male target, respectively.

The reproducibility results for the samples containing 1 ng/µL are 
shown graphically in Figure 6-20. At this concentration, the range of 
standard deviations for each target is:

• Human Target: 0.027 to 0.083
• Male Target: 0.039 to 0.142

Figure 6-20 Reproducibility at 1ng/µL using the 
Quantifiler® Duo DNA Quantification Kit
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Case-Type
Samples
(Std. 2.6)

This experiment was performed to evaluate different sample types 
that are commonly processed in a forensic laboratory.

Experiment

A variety of forensic-type samples (Table 6-8) were prepared using 
semen, saliva and blood obtained from one or two male individual 
donors (a and b). The blood samples were spiked with inhibitors, 
spotted onto fabric/filter paper, and organically extracted. The saliva 
samples were spotted onto swabs and the semen samples were spotted 
onto fabric. A subset of these samples (1-4) were also extracted using 
other commercially available methods including Chelex® resin, the 
QIAGEN QIAamp® DNA Blood Mini Kit and the Promega DNA 
IQ™ Kit.  For details on the preparation of the samples see Table 6-8. 

Extracted DNA was quantified in triplicate using the Quantifiler® 
Duo DNA Quantification Kit. Based on the results from the 
Quantifiler Duo kit (RPPH1 human target), approximately 1.0 ng of 
human genomic DNA was added to each Identifiler® Kit reaction and 
approximately 0.1 ng  of human genomic DNA was added to each 
MiniFiler™ Kit reaction. 

Table 6-8 Preparation of samples

Sample Sample Type Volume and Substrate

1 Saliva Swab (a)  50 µL on cotton swab

2 Saliva Swab (b)  50 µL on cotton swab

3 Blood Stain (a)  5 µL on fabric

4 Blood Stain (b)  5 µL on fabric

5 Blood Stain  5 µL on denim

6 Blood Stain  5 µL on filter paper

7 Blood Stain 5 µL spiked with inhibitor mix on 
fabric

8 Semen Stain 1 µL on fabric
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Results

The Quantifiler® Duo Kit reactions performed on the case-type 
samples yielded a range of DNA concentrations from 0.31 ng/µL to 
14.66 ng/µL for the SRY male-specific target and from 0.27 ng/µL to 
13.28 ng/µL for the RPPH1 human target (Table 6-9). 

Table 6-9 Quantifiler® Duo Quantification Kit reactions performed on case-type samples

Sample 
# 

Extraction 
Method Vendor

Quantity 
(SRY) 
ng/µL

Quantity 
(RPPH1) 

ng/µL

CT 
Value 
(IPC)

SRY-
RPPH1 % 
difference

1 Organic In House 2.060 2.010 29.74 2.5

2 Organic In House 11.000 11.350 29.77 -3.1

3 Organic In House 0.820 0.908 29.84 -9.7

4 Organic In House 2.090 2.070 29.68 1.0

5 Organic In House 1.370 0.757 32.54 81.0

6 Organic In House 1.350 1.340 29.48 0.7

7 Organic In House 1.840 1.720 29.69 7.0

8 Organic In House 1.780 1.820 29.47 -2.2

1 Chelex In House 0.506 0.505 28.91 0.2

2 Chelex In House 14.660 13.280 29.00 10.4

3 Chelex In House 0.307 0.267 30.79 15.0

4 Chelex In House 0.425 0.332 30.88 28.0

1 Silica Membrane QIAGEN, Blood kit 0.457 0.443 29.90 3.2

2 Silica Membrane QIAGEN, Blood kit 4.020 3.880 29.80 3.6

3 Silica Membrane QIAGEN, Blood kit 0.306 0.312 29.76 -1.9

4 Silica Membrane QIAGEN, Blood kit 0.522 0.517 29.73 1.0

1 Magnetic Beads Promega, DNA IQ 0.732 1.840 29.59 -60.2

2 Magnetic Beads Promega, DNA IQ 2.620 9.760 29.80 -73.2

3 Magnetic Beads Promega, DNA IQ 0.645 0.715 29.60 -9.8

4 Magnetic Beads Promega, DNA IQ 1.140 1.460 29.42 -21.9
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For all samples extracted using the organic extraction method, human 
and male DNA quantities were similar except for the blood stain on 
denim (Table 6-8, sample 5). For this sample the quantity of male 
DNA was 81% higher than the quantity obtained from the human 
target (Table 6-9). The blood stain on denim is a challenging sample 
due to inhibitors present on the denim substrate and in the blood. The 
lower quantity of total human DNA may result from inhibition of the 
amplification of the RPPH1 target. The presence of PCR inhibitors is 
suggested by the greater CT value obtained for the IPC.

For the other extraction methods, the human and male DNA 
quantities for all samples were similar except for the saliva swabs 
(Table 6-8, samples 1 and 2) extracted with the Promega DNA IQ™ 
Kit (Table 6-9).

Complete and interpretable STR profiles were obtained for all the 
samples analyzed. Peak heights from 500 to 4000 rfu were obtained 
for samples analyzed using the Identifiler® Kit (DNA target amount 
was 1 ng/rxn), and from 200 to 2000 rfu for samples analyzed using 
the MiniFiler™ Kit (DNA target amount was 0.1 ng/rxn). 

Representataive STR profiles obtained for the phenol-chloroform 
extracted samples are shown in Figure 6-21 and Figure 6-22.
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Figure 6-21 STR analysis using the Identifiler® Kit and organic 
extracted case-type samples 

1
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8

Legend: The sample numbers to the left of the figure refer to the sample numbers in Table 6-5.
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Figure 6-22 STR analysis using the MiniFiler™ Kit and organic 
extracted case-type samples

Population
Studies (Std. 2.7)

Human DNA samples from three population groups were analyzed to 
verify the ability to obtain male and human quantification results 
using the Quantifiler® Duo kit.

Experiment 

Purified genomic DNA samples from 534 human individual donors 
from Hispanic, Caucasian, and African American population groups 
were analyzed using the Quantifiler® Duo DNA Quantification Kit.

All DNA samples were previously extracted from blood specimens 
using the Applied Biosystems BloodPrep® DNA Chemistry and ABI 
PRISM® 6100 Nucleic Acid PrepStation. The samples were 
previously quantified using the Quantifiler® Human DNA 
Quantification Kit.

1
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3

4

5

6

7

8

Legend: The sample numbers to the left of the figure refer to the sample numbers in Table 6-5.
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The number of male and female samples, in each of the population 
groups tested, is detailed in Table 6-10. Approximately 1 ng of 
purified genomic DNA was used from the panel for each 
Quantifiler® Duo Kit reaction.

Results 

The Quantifiler® Duo DNA Quantification Kit detected and 
quantified DNA in all 534 human DNA samples.

• All 375 male DNA samples exhibited the SRY signal (see 
Table 6-11). 

• The SRY signal was not detected for any of the female samples 
tested (see Table 6-11). 

• The human-male DNA quantity value (SRY) was within ± 25% 
of the total human quantity value (RPPH1) obtained for most of 
the male samples (data not shown). 

• 5 of the 375 male samples tested (Table 6-12) yielded SRY 
quantity values that deviated from the RPPH1 quantity values by 
> 25%. This may have resulted from duplication of the SRY 
gene in these DNA samples.

Table 6-10 Distribution of samples used for population studies

Population Male Samples Female Samples

Caucasian 130 60

African-American 116 24

Hispanic 129 75

Total/gender 375 159

Total 534
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Mixture Study
(Std. 2.8)

The mixture studies were designed to simulate circumstances in 
which a small component of male DNA must be discerned from a 
high background of female DNA. When interpreting results, consider 
that evidence samples may contain DNA from more than one 
individual.

Experiment 1

Mixture samples containing 0.2 ng/µL of human male DNA and 
varying amounts of female DNA were prepared. The ratio of male 
and female DNA in these samples was 1:0, 1:1, 1:5, 1:10, 1:20 and 
0:1 (Table 6-13). The mixture samples were processed in triplicate 
using the Quantifiler® Duo DNA Quantification Kit to determine the 
concentration of total human DNA (RPPH1 target) and male DNA 
(SRY target).

Table 6-11 Quantification of DNA in the samples from different 
population groups

Sex
Quantification Results Obtained

Duo Human Duo Male

Male (375) 100% 100%

Female (159) 100% 0%

Table 6-12 Quantification results for the five samples exhibiting >25% variation in the 
quantities of total human and male DNA

Sample 
#

Population Duo Human 
(ng/µL)

Duo Male 
(ng/µL)

IPC CT
Male-Human 
% difference

417 Caucasian 0.688 1.300 29.837 88.953

34 African-American 0.244 0.475 29.957 94.672

64 African-American 0.230 0.458 29.733 99.130

129 African-American 0.253 0.444 29.847 75.494

183 African-American 0.329 0.542 29.803 64.742
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In addition, using the results from the RPPH1 human target, 
approximately 1.0 ng of human genomic DNA from each sample was 
added to an Identifiler® Kit reaction. Using the results from the SRY 
male target, approximately 1.0 ng of human genomic DNA from each 
sample was added to a Yfiler® kit reaction. 

Results 1

The quantification results obtained using the Quantifiler® Duo DNA 
Quantification Kit are summarized in Table 6-13 and shown 
graphically in Figure 6-23. For all samples, the male DNA produced 
consistent quantification values, regardless of the amount of female 
DNA present. Thus, the ability to quantify the male DNA was not 
adversely affected by the presence of the quantities of female DNA 
investigated. 

In addition, the ratios of male and female DNA in the mixture 
samples derived from the quantification results correlated well with 
the expected ratios. 

Table 6-13 Mixture Study 1: ratio and quantification results

Expected 
Male/Female

DNA Ratio

SRY
Quantity

ng/µL

RPPH1 
Quantity

ng/µL

Measured 
Male : Female 

DNA Ratio

 1:0 0.228 0.236  1:0.04

 1:1 0.229 0.507  1:1.21

 1:5 0.240 1.410  1:4.88

 1:10 0.280 3.030  1:9.82

 1:20 0.235 4.070  1:16.32

 0:1 Female 0.217    -----
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Figure 6-23 Mixture Study 1: Quantification values obtained for a 
constant amount of male DNA in a background of increasing 
female DNA

Based on the results from the RPPH1 target, approximately 1.0 ng of 
human genomic DNA from each sample was analyzed using the 
Identifiler® Kit  (Figure 6-24). As expected, the peak height of male 
alleles decreased with increases in the ratio of female to male DNA, 
reflecting the reducing amount of male DNA present in each sample. 

Interpretation of the minor male profile in such mixture samples was 
challenging due to the occurrence of shared alleles (minor-male 
alleles at stutter positions of female alleles) and dropout of minor 
alleles. Alleles from the minor male contributor were interpretable in 
the mixture samples having 1:1, 1:5 and 1:10  ratios of  male:female 
DNA, as indicated by the arrows in Figure 6-24.
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Figure 6-24 Mixture study 1: STR analysis using the 
Identifiler® Kit

1:0

1:1

1:5

1:10

1:20

0:1

Top panel: Male contributor DNA profile. Bottom panel: Female contributor DNA profile. Middle 
panels: Male:female DNA mixtures. Arrow denotes male contributor alleles at one locus.
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Based on the results from the SRY target, approximately 1.0 ng of 
human male DNA from each sample was profiled using the Yfiler® 
Kit (Figure 6-25). The Yfiler® Kit amplifies STR targets on the 
human Y-chromosome only. Therefore, one would expect a good 
correlation between the quantification values obtained from the SRY 
target in the Quantifiler® Duo DNA Quantification Kit and the 
performance of the Yfiler® Kit. Complete, conclusive, and consistent 
male profiles were obtained from all mixture samples investigated.

Figure 6-25 Mixture Study 1: STR analysis using the Yfiler® Kit

1:0

1:1

1:5

1:10

1:20

Top panel: Male contributor DNA profile. Remaining panels: Male:female DNA mixtures.
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Experiment 2

The limit of detection of male DNA in the presence of large excesses 
of female DNA was studied. Mixture samples were prepared 
containing 25 pg/µL of male DNA and increasing quantities of 
female DNA, resulting in M:F ratios of 1:0, 1:50, 1:100, 1: 200, 
1:500, 1:800, 1:1000 and 0:1. The mixture samples were processed in 
triplicate using the Quantifiler® Duo DNA Quantification Kit to 
determine the concentration of total human genomic DNA (RPPH1 
target) and male DNA (SRY target). 

Based on the results from the SRY male target, approximately 1.0 ng 
of human genomic DNA from each sample was added to a Yfiler® 
Kit reaction. 

Results 2

The male DNA was detected and quantified in all mixture samples 
with as high as a 1:1000 M:F ratio using the Quantifiler® Duo DNA 
Quantification Kit (Table 6-14 and Figure 6-26). Detection of male 
DNA as low as 25 pg/µL in the presence of 1000-fold excess female 
DNA demonstrates the robustness and specificity of the Quantifiler® 
Duo DNA Quantification Kit. The observed ratio of the male and 
female DNA varied between 10% to 40% from the expected ratio 
most likely because of stochastic variations in the PCR. 

Table 6-14 Mixture study 2: ratio and quantification results

Male/Female
DNA Ratio

SRY
Quantity

ng/µL

RPPH1 
Quantity

ng/µL

Measured 
Male : Female 

DNA Ratio

 1:0 0.027 0.026  1:0.04

 1:50 0.029 1.260  1:42.45

 1:100 0.029 2.460  1:83.25

 1:200 0.022 6.405  1:288.16

 1:500 0.025 13.770  1:545.43

 1:800 0.027 24.410  1:896.43

 1:1000 0.020 28.210  1:1388.66

 0:1 Female 0.016    -----
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Figure 6-26 Mixture study 2: quantification graph

Based on the results from the SRY target, the maximum allowed 
volume (10 µL) of each mixture sample was profiled using the 
Yfiler® Kit (Figure 6-27). Complete, conclusive and consistent male 
profiles were obtained from all mixture samples investigated. The 
results demonstrate the utility of the Quantifiler® Duo DNA 
Quantification Kit in the analysis of mixture samples.
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Figure 6-27 Mixture study 2: STR analysis using the Yfiler® Kit

Precision and
Accuracy
(Std. 2.9)

The precision and accuracy of the Quantifiler® Duo Kit was assessed 
by replicate standard curve analysis. 

Experiment 

The precision of the Quantifiler® Duo DNA Quantification Kit was 
tested by performing two runs on different days (one run per day) on 
three different instruments.

One set of eight serial dilutions was prepared containing 50, 16.7, 
5.56, 1.85, 0.62, 0.21, 0.068 and 0.023 ng/µL of the human male 
DNA standard included in the Quantifiler® Duo DNA Quantification 
Kit. Six reaction plates were set up and each of them contained 
10 replicates of the 8 dilutions. Two plates per instrument were run on 
three different 7500 Real-time PCR System instruments using 
recommended thermal cycler conditions for the Quantifiler® Duo 
DNA Quantification Kit. 

1:0

1:50

1:100

1:200

1:500

1:800

1:1000

Top panel: Male contributor DNA profile. Remaining panels: Male:female DNA mixtures.
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The two runs were performed on two different days, using the same 
three 7500 Real-Time PCR System instruments. For each dilution, 
the CT values for RPPH1 (VIC), SRY (FAM) and IPC (NED) signals 
were recorded for all 60 reactions. Slope, R2 and Y-intercept values 
were also computed. 

Results 

Table 6-15 shows the means and standard deviations of the CT values 
for RPPH1, SRY, and IPC targets calculated for each quantification 
standard dilution across all 6 plates. 

Figure 6-28, Figure 6-29, and Figure 6-30 provide the human, human 
male, and IPC CT mean values obtained using the Quantifiler® Duo 
DNA Quantification Kit. 

Table 6-15 Precision: CT values

Quantification 
Standard 
Dilution 
(ng/µL)

Human Male IPC

CT 
(Mean)

Standard 
Deviation

CT 
(Mean)

Standard 
Deviation

CT 
(Mean)

Standard 
Deviation

50 23.36 0.26 23.92 0.19 29.80 0.35

16.7 24.98 0.23 25.55 0.16 29.61 0.18

5.56 26.62 0.28 27.22 0.15 29.56 0.17

1.85 28.26 0.23 28.88 0.18 29.57 0.19

0.62 29.79 0.29 30.44 0.19 29.64 0.19

0.21 31.32 0.34 32.01 0.28 29.66 0.21

0.068 32.83 0.32 33.61 0.40 29.62 0.19

0.023 34.48 0.58 35.33 0.63 29.55 0.18
6-50 Quantifiler® Duo DNA Quantification Kit User’s Manual



Developmental Validation
Figure 6-28 Precision using the Quantifiler® Duo DNA 
Quantification Kit (RPPH1 human target) at the standard curve 
concentrations 

Figure 6-29 Precision using the Quantifiler® Duo DNA 
Quantification Kit (SRY male target) at the standard curve 
concentrations 
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Figure 6-30 Precision using the Quantifiler® Duo DNA 
Quantification Kit (IPC target) at the standard curve 
concentrations 

For each sample, the CT values obtained for the RPPH1 target were 
lower than those obtained for the SRY target because there are two 
copies of the autosomal human target locus and only one copy of the 
Y chromosome target locus per genome equivalent. 

The CT values did not vary significantly from run to run or from 
instrument to instrument. The data showed that at lower DNA 
concentrations, the standard deviations increased, most likely due to 
stochastic effects. 

Systematic differences between instruments are not expected to affect 
final sample quantification results; when samples and quantification 
standards are run on the same plate and instrument, the CT values are 
affected proportionately.
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Optimization of
PCR Reaction

Conditions
(Std. 2.10.1) &

Effect of
Coamplification

in Multiplex PCR
(Std. 2.10.3)

The quantities of critical reagents in the PCR mix such as primers, 
probes, and IPC template were optimized using the following thermal 
cycling conditions:

• Hold: 50°C 2 min.
• Hold: 95°C 10 min.
• Cycle: 95°C 15 sec, 60°C 1 min for 40 cycles.

The primers and probes for amplification and detection of RPPH1, 
SRY, and IPC targets were investigated at concentrations ranging 
from 50 to 725 nM. In a separate experiment, copies of the IPC 
varied from 1,000 to 40,000 copies per assay.

Contamination
(Std. 3.6)

Analysis of non-template control samples was performed to 
demonstrate that the Quantifiler® Duo assay did not generate results 
due to the presence of contaminating DNA.

Experiment 

To test for contamination, all standard assay parameters were used, 
except that the number of cycles was extended from 40 to 50 in the 
PCR amplification cycling step.

A 96-well plate was set up with 95 non-template controls (NTCs) and 
one positive control sample (at a concentration of approximately 20 
ng/µL). The number of PCR cycles was increased from 40 to 50 in 
this experiment to study the performance at a higher stringency. 

Results 

None of the 95 NTCs exhibited any detectable signal for the human 
and male targets in the VIC and FAM channels, respectively 
(Figure 6-31). The CT values for the IPC signal (NED) fell within a 
range of variation of 1 CT, which is within the normal variation of the 
TaqMan® assay. The positive control sample provided the expected 
CT values for human and male targets.
Quantifiler® Duo DNA Quantification Kit User’s Manual 6-53



Chapter 6 Experiments and Results
Figure 6-31 NTC and positive control

Correlation
Studies

Quantification of DNA is a step in the STR analysis workflow that 
provides a value obtained by measuring the DNA content of a given 
sample against a reference (standard DNA sample). Quantification 
results may vary based on the method used; e.g., UV absorbance, 
binding of intercalating dyes, hybridization, PCR, and so on. 

Among the different PCR-based quantification methods, the quantity 
of DNA obtained for any given sample may vary due to different 
aspects of PCR (see Results section below). The ultimate goal of the 
DNA quantification step in the STR analysis workflow is not to 
obtain an absolute value, but to determine the volume of the DNA 
extract to be used for amplification to produce high quality STR 
genotyping results. 

Experiment 

Four male genomic DNA samples (A through D) and one female 
genomic DNA sample (sample E) at 20.0, 10.0, 1.0, 0.1 and 0.05 
ng/µL were quantified in triplicate using the Quantifiler® Duo,  
Quantifiler® Human and Quantifiler® Y Human Male Quantification 
Kits.

Positive Control 
(Human & Male)

IPC

NTC Wells 
(Human & Male)
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Results 

All male samples provided quantification results for both human and 
male targets using the Quantifiler® Duo, Quantifiler® Human and 
Quantifiler® Y Human Male DNA Quantification Kits (Table 6-16). 
No detectable male target signal was obtained for the female DNA 
sample, at any concentration, using the Quantifiler® Duo and 
Quantifiler® Y Human Male DNA Quantification Kits. The 
quantities of human and male DNA obtained from the Quantifiler® 
Duo DNA Quantification Kit were similar to the quantities obtained 
using either the Quantifiler® Human or Quantifiler® Y Human Male 
DNA Quantification Kit. 

The differences in the quantities of DNA obtained in the present 
experiment may be due to one or more of the following:

• The difference in the amplification targets used for 
quantification of human DNA: RPPH1 in the Quantifiler® Duo 
DNA Quantification Kit and  hTERT in the Quantifiler® Human 
DNA Quantification Kit.

• The difference in the sizes of the human DNA targets: 140 bases 
in the Quantifiler® Duo DNA Quantification Kit and 62 bases in 
the Quantifiler® Human DNA Quantification Kit.

• The difference in the sizes of the male DNA targets: 130 bases 
in the Quantifiler® Duo DNA Quantification Kit and 64 bases in 
the Quantifiler® Y Human Male DNA Quantification Kit; 
though in both kits the male target is SRY gene.

• The differences in assay complexity: the Quantifiler® Duo DNA 
Quantification Kit is a triplex PCR assay, and the Quantifiler® 
Human and Quantifiler® Y Human Male DNA Quantification 
Kits are duplex PCR assays.

• Differences in the quantification standards used in the respective 
kits: human male genomic DNA in the Quantifiler® Duo DNA 
Quantification Kit; cell line DNA in the Quantifiler® Human 
and Quantifiler® Y Human Male DNA Quantification Kits. 

• Differences in the optimized reaction mix: each PCR reaction 
mix is optimized to deliver the expected performance for a given 
kit.

Applied Biosystems recommends that laboratories determine the 
optimum amount of input DNA required for each STR genotyping 
system based on the quantification values obtained using the 
Quantifiler® Duo DNA Quantification Kit.
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6-56 Table 6-16 Correlation of DNA quantification using the Quantifiler® Duo,  Quantifiler® Human and Quantifiler® Y 

 Quantity Male

uantifiler Y Mean 
% difference

16.910 18.882
9.020 -0.410
1.120 -23.750
0.113 -26.549
0.060 -23.333

20.380 13.283
10.650 5.352
1.310 -12.443
0.160 -31.250
0.082 -40.244

20.270 14.021
9.220 0.325
1.110 -19.459
0.099 9.091
0.046 -4.348

22.800 16.171
11.740 11.499
1.500 -15.800
0.145 -16.552
0.074 -1.351
female female
female female
female female
female female
female female
Q
uantifiler ® D

uo D
N

A
 Q

uantification K
it U

ser’s M
anual

Human Male Quantification Kit

Sample Expected 
Quantity Mean Quantity Human Mean

Name ng/µL Quantifiler 
Duo

Quantifiler 
Human

Mean 
% difference

Quantifiler 
Duo Q

A 20.000 21.153 21.160 -0.033 20.103
A 10.000 9.110 10.440 -12.739 8.983
A 1.000 0.869 0.831 4.573 0.854
A 0.100 0.091 0.071 28.169 0.083
A 0.050 0.043 0.044 -2.273 0.046
B 20.000 24.363 27.690 -12.015 23.087
B 10.000 11.493 12.290 -6.485 11.220
B 1.000 1.143 1.080 5.833 1.147
B 0.100 0.104 0.098 6.122 0.110
B 0.050 0.061 0.044 38.636 0.049
C 20.000 22.513 24.740 -9.002 23.112
C 10.000 8.720 11.110 -21.512 9.250
C 1.000 0.822 1.010 -18.614 0.894
C 0.100 0.098 0.129 -24.031 0.108
C 0.050 0.044 0.056 -21.429 0.044
D 20.000 27.283 16.730 63.078 26.487
D 10.000 13.263 10.610 25.005 13.090
D 1.000 1.217 1.470 -17.211 1.263
D 0.100 0.118 0.100 18.000 0.121
D 0.050 0.059 0.066 -10.606 0.073
E 20.000 24.910 27.880 -10.653 female
E 10.000 12.107 13.270 -8.764 female
E 1.000 1.137 1.300 -12.538 female
E 0.100 0.116 0.162 -28.395 female
E 0.050 0.056 0.060 -6.667 female
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